Copyright notice

©2008 WATERS CORPORATION. PRINTED IN THE UNITED STATES OF AMERICA AND IRELAND. ALL RIGHTS RESERVED. THIS DOCUMENT OR PARTS THEREOF MAY NOT BE REPRODUCED IN ANY FORM WITHOUT THE WRITTEN PERMISSION OF THE PUBLISHER.

The information in this document is subject to change without notice and should not be construed as a commitment by Waters Corporation. Waters Corporation assumes no responsibility for any errors that may appear in this document. This document is believed to be complete and accurate at the time of publication. In no event shall Waters Corporation be liable for incidental or consequential damages in connection with, or arising from, its use.

Trademarks

Waters and Millennium are registered trademarks of Waters Corporation, and Empower and THE SCIENCE OF WHAT’S POSSIBLE are trademarks of Waters Corporation.

Citrix and ICA are registered trademarks of Citrix in the United States and/or other countries.

Microsoft, Internet Explorer, Windows, and Windows Vista are registered trademarks of Microsoft Corporation in the United States and/or other countries.

UNIX is a registered trademark of The Open Group.

Oracle is a registered trademark of Oracle Corporation and/or its affiliates.

Other registered trademarks or trademarks are the sole property of their owners.
### Customer comments

Waters' Technical Communications department invites you to tell us of any errors you encounter in this document or to suggest ideas for otherwise improving it. Please help us better understand what you expect from our documentation so that we can continuously improve its accuracy and usability.

We seriously consider every customer comment we receive. You can reach us at tech_comm@waters.com.

### Contacting Waters

Contact Waters® with enhancement requests or technical questions regarding the use, transportation, removal, or disposal of any Waters product. You can reach us via the Internet, telephone, or conventional mail.

**Waters contact information:**

<table>
<thead>
<tr>
<th>Contacting medium</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet</td>
<td>The Waters Web site includes e-mail addresses for Waters locations worldwide. Visit <a href="http://www.waters.com">www.waters.com</a>, and click Waters Division &gt; Waters Division &gt; Regional/Global Contacts.</td>
</tr>
<tr>
<td>Telephone and fax</td>
<td>From the USA or Canada, phone 800 252-HPLC, or fax 508 872 1990. For other locations worldwide, phone and fax numbers appear in the Waters Web site.</td>
</tr>
</tbody>
</table>
| Conventional mail          | Waters Corporation  
34 Maple Street  
Milford, MA 01757  
USA |
Empower Software

Intended use

Use the Waters Empower 2 Software for acquiring, processing, reporting, and managing your chromatographic information.

Safety information

See the operator’s guides of the instruments or devices associated with this software product for information on how to safely operate and maintain them.
# Table of Contents

1 Introduction ............................................................................................................. 1-1  
  System overview ..................................................................................................... 1-2  
  Software description ............................................................................................... 1-3  
    Server software .................................................................................................... 1-3  
    Client software ................................................................................................... 1-3  
  System administration ............................................................................................ 1-4  
    System administrator qualifications ...................................................................... 1-5  
    System administration tasks .............................................................................. 1-6  

2 Managing the server ............................................................................................. 2-1  
  Network considerations ......................................................................................... 2-2  
    Group Policy Objects .......................................................................................... 2-2  
  Windows user accounts ........................................................................................ 2-3  
    Windows administrator account privileges ...................................................... 2-3  
    Windows domain user account privileges ....................................................... 2-4  
  Managing the server disk space ........................................................................... 2-4  
    Checking free disk space ................................................................................. 2-4  
    Increasing free disk space ................................................................................ 2-5  
    Defragmenting the hard disk ............................................................................. 2-6  

3 Managing the Empower 2 database ...................................................................... 3-1  
  Oracle Enterprise Manager console ....................................................................... 3-2  
    Accessing the OEM database control console ............................................... 3-2  
  Recording database information .......................................................................... 3-3  
  Creating an additional database instance ............................................................ 3-4  
    Creating an additional database instance ....................................................... 3-6  
    Creating Empower 2 structures in the new database ...................................... 3-10
Managing Empower 2 database (Oracle) accounts ........................................ 3-12
Changing the Oracle user accounts passwords......................................... 3-12

Shutting down and starting up the Empower 2 database ..................... 3-12

Configuring the Windows DBA account .................................................. 3-13
Adding a user or group to the ORA_DBA group .................................... 3-13
Granting the Windows DBA user batch job privileges ......................... 3-14
Shutting down the Empower 2 database .............................................. 3-15
Starting up the Empower 2 database.................................................. 3-17

Database file organization ..................................................................... 3-18
Server configurations ........................................................................... 3-18
Database file organization ................................................................... 3-18

Archiving alert logs .............................................................................. 3-21

Adding datafiles to the database ......................................................... 3-21

4 Managing Empower 2 software ......................................................... 4-1

Scope ...................................................................................................... 4-2

Using the TNS_Admin environment variable ....................................... 4-2
Modifying the local security policy configuration on Windows Server 2003 4-2
Configuring a shared tnsnames.ora file ............................................... 4-3

Defining net service names (database aliases) ...................................... 4-4
Special considerations for Empower 2 Personal clients ....................... 4-5

Logging in to Empower 2 as the default system administrator ............ 4-5
Changing the Empower 2 system user account password ................... 4-6
Changing the Empower 2 database password ..................................... 4-6

Managing project hierarchies ............................................................... 4-7
Benefits of the hierarchical structure .................................................. 4-8

Managing raw data files ...................................................................... 4-10
Moving project raw data files.............................................................. 4-11
Viewing the current raw data paths..................................................... 4-11
Disconnecting dead connections ................................................................. 6-6
Audit trail settings for restored projects ...................................................... 6-6
Software problems .......................................................................................... 6-8
  ACQUITY UPLC problems .......................................................................... 6-10
Hardware problems ....................................................................................... 6-11
Troubleshooting procedures ......................................................................... 6-16
  Evaluating Windows error messages.......................................................... 6-16
  Evaluating Empower 2 software error messages........................................ 6-17
  Evaluating Oracle error messages.............................................................. 6-17
A Safety Advisories ......................................................................................... A-1
  Warning symbols .......................................................................................... A-2
    Task-specific hazard warnings................................................................. A-2
    Warnings that apply to particular instruments, instrument components, and sample types................................................................. A-3
  Caution symbol ............................................................................................ A-5
  Warnings that apply to all Waters instruments ............................................ A-5
  Electrical and handling symbols ................................................................. A-11
    Electrical symbols.................................................................................... A-11
    Handling symbols .................................................................................... A-12
B Log forms ............................................................................................................. B-1
  Database Initialization Parameters ................................................................. B-3
  Database Storage Information (Control Files) .............................................. B-4
  Database Storage Information (Tablespace) ................................................ B-5
  Data file Information ....................................................................................... B-6
  Data file Information (Redo logs) ................................................................. B-8
  Disk space usage log ..................................................................................... B-9
  Database backup log ..................................................................................... B-10
  Full disk backup log ..................................................................................... B-11
  System service log ....................................................................................... B-12
  System problem log .................................................................................... B-13
  Hardware service information sheet ............................................................ B-14
  Software service information sheet ............................................................. B-14
1 Introduction

This chapter describes the Waters® Empower™ 2 Enterprise client/server system and the Empower 2 Workgroup configuration. It describes the Empower 2 system, hardware and software requirements, system administrative tasks, and security.

This guide was revised to include Empower 2 Feature Release 5 functionality. Empower 2 FR 5 includes all prior Empower 2 service packs and feature releases (Service Packs A through E and feature releases 1 through 4). This guide refers to Empower configurations and Empower software as:

- Empower, for Empower (build 1154).
- Empower 2, for Empower (build 2154).
- Empower 2 FR 5, for Empower (build 2154 feature release 5).

This guide is for administrators of both the Empower 2 Enterprise client/server system and the Empower 2 Workgroup configuration. References in this guide to an Enterprise server also pertain to a Workgroup primary PC. References to an Enterprise client also pertain to a Workgroup secondary PC and a Workgroup primary PC.

Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>System overview</td>
<td>1-2</td>
</tr>
<tr>
<td>Software description</td>
<td>1-3</td>
</tr>
<tr>
<td>System administration</td>
<td>1-4</td>
</tr>
</tbody>
</table>
System overview

The Empower 2 Enterprise client/server system and Workgroup configuration are networked versions of the Empower 2 Personal standalone workstation. The architecture of these systems consists of these parts, as shown in the following figure:

- A central database on the server
- Distributed acquisition
- Distributed processing
- Security

Example of Empower 2 Enterprise and Workgroup system architecture
Software description

This section describes the software components required to implement the Empower 2 Enterprise or Workgroup systems.

Server software

The server software consists of these components:

- Oracle® Enterprise Edition version 10.2.0.3.

Windows Server operating systems

The Windows Server operating systems provide built-in networking utilities, protocol handlers, and services including basic file and print services and client/server application functionality.

Oracle Enterprise Edition 10g server

The Empower 2 relational database resides on the server in an Empower 2 Enterprise client/server system or an Empower 2 Workgroup configuration. Information from projects, such as processed results, sample identifiers, and methods is stored in the Empower 2 database. The raw data files are not stored in the database. The raw data files are stored on the same server disk drive or on a different one.

Oracle client software provides the Empower 2 application running on the client computer with access to the Empower 2 database.

Client software

The client software runs on the PC and communicates with the corresponding software components on the server, as applicable. The client software includes these items:

- Windows Vista Enterprise Service Pack 1 or Windows XP Service Pack 2 Professional operating system
- Empower 2 Enterprise or Empower 2 Workgroup client software
• Oracle Client Software version 10.2.0.3
• Internet Explorer® version 7.0.
• Internet Explorer version 6.0 is supported on Windows 2000 Server SP4 only.

Windows Vista Enterprise SP1 or Windows XP SP2 operating system

The client’s Windows Vista or XP operating system provides the connectivity software that communicates with the server through TCP/IP. Windows Vista or XP, combined with TCP/IP services for the operating system, provide the Empower 2 software with access to these components:
• Raw data files on the server or other computer on the network
• Network printers
• Empower 2 clients and LAC/E\textsuperscript{32} acquisition servers

See also: Refer to the release notes for your LAC/E\textsuperscript{32} acquisition server to determine which OS is supported.

Empower 2 Enterprise or Workgroup client software

Empower 2 lets you acquire data and control chromatographic instrumentation, process data interactively or in the background, customize management of project information, and customize report design and generation.

Oracle client software

Oracle client software provides Empower 2 software with access to the Empower database through TCP/IP.

System administration

Managing the Empower 2 Enterprise or Workgroup system involves maintaining all the hardware components, operating system software, networking software, and application programs that make up the Empower 2 software. It also requires system administrators to know the system’s workload so that they can anticipate changes, problems, and growth.
System administrator qualifications

System administrators are responsible for the smooth and efficient daily operation of the Empower system. They control and maintain the system by performing the system administration tasks listed in “System administration tasks” on page 1-6.

To effectively administer the Empower 2 system, administrators must be familiar with the operation of the hardware and software listed in the following tables.

### Hardware

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server computer and peripherals</td>
<td>Server documentation</td>
</tr>
<tr>
<td>Waters LAC/E\textsuperscript{32} Acquisition Server</td>
<td>Empower 2 System Installation and Configuration Guide, Revision B</td>
</tr>
<tr>
<td>Empower 2 clients</td>
<td>Empower 2 System Installation and Configuration Guide, Revision B and the Empower 2 online Help</td>
</tr>
<tr>
<td>PCs and printers</td>
<td>PC and printer manufacturer’s documentation</td>
</tr>
</tbody>
</table>

### Software

<table>
<thead>
<tr>
<th>Software</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Empower 2 Feature Release 5 Software</td>
<td>Empower 2 System Installation and Configuration Guide, Revision B and the Empower 2 online Help</td>
</tr>
<tr>
<td>Windows Vista Enterprise operating system</td>
<td>Microsoft\textsuperscript{®} Windows documentation</td>
</tr>
<tr>
<td>Windows 2000 or Windows Server 2003 operating system</td>
<td>Microsoft\textsuperscript{®} Windows documentation</td>
</tr>
<tr>
<td>Oracle 10g</td>
<td>Oracle10g Server online documentation</td>
</tr>
<tr>
<td>Microsoft TCP/IP</td>
<td>Microsoft Windows Help</td>
</tr>
</tbody>
</table>
System administration tasks

This section describes the routine and periodic system administration tasks administrators need to perform to keep the Empower 2 system running efficiently. Several tools help with those tasks:

- Empower 2 online Help
- Empower 2 Configuration Manager
- Oracle10g Help System and Utilities

Routine tasks

Routine system administration tasks are those that you should perform regularly: once daily, once each shift (every 8 hours), or once a week. Routine system administration tasks apply to both the server and the client.

Periodic tasks

Periodic system administration tasks are those that you perform occasionally or as the need arises. System Administrators must determine when to perform periodic system administration tasks based on their Empower 2 system’s use and requirements.

Periodic system administration tasks apply to both the server and the client.

Tasks performed from the Empower 2 server

Typical server tasks and chapter references are in the following table.

Tasks performed from the Empower 2 server

<table>
<thead>
<tr>
<th>Task</th>
<th>Reference</th>
<th>Recommended frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checking disk space and status</td>
<td>“Managing the server disk space” on page 2-4</td>
<td>Daily</td>
</tr>
<tr>
<td>Backing up the Empower database</td>
<td>“Backing up the Empower 2 database using scripts” on page 5-2</td>
<td>Weekly cold backups with daily hot backups</td>
</tr>
</tbody>
</table>
Tasks performed from the Empower 2 server (Continued)

<table>
<thead>
<tr>
<th>Task</th>
<th>Reference</th>
<th>Recommended Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleting or archiving unneeded files</td>
<td>“Managing the server disk space” on page 2-4</td>
<td>As needed</td>
</tr>
<tr>
<td>Restoring the Empower database</td>
<td>“Restoring the Empower 2 database” on page 5-9</td>
<td>As needed</td>
</tr>
<tr>
<td>Archive alert log</td>
<td>“Archiving alert logs” on page 3-21</td>
<td>Quarterly</td>
</tr>
<tr>
<td>Managing raw data files</td>
<td>“Managing raw data files” on page 4-10</td>
<td>As needed</td>
</tr>
</tbody>
</table>

Tasks performed from an Empower 2 client

You initiate periodic and routine client tasks from the Empower Configuration Manager on the client PC. Typical routine tasks that apply to clients are in the following table.

Tasks performed from an Empower client

<table>
<thead>
<tr>
<th>Task</th>
<th>Reference</th>
<th>Recommended Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backing up, restoring, and deleting projects</td>
<td>Empower 2 online Help</td>
<td>As needed</td>
</tr>
<tr>
<td>Managing user types</td>
<td>Empower 2 online Help</td>
<td>As needed</td>
</tr>
<tr>
<td>Managing users</td>
<td>Empower 2 online Help</td>
<td>As needed</td>
</tr>
<tr>
<td>Managing groups</td>
<td>Empower 2 online Help</td>
<td>As needed</td>
</tr>
</tbody>
</table>

System administrator’s log

Set up and maintain a system administrator’s log to record all system administration tasks. Keep the log next to the system to record system administration information, such as the amount of free disk space or the date of the last backup. Also, keep a record of any problems you encounter with the system as well as their resolution.

See Appendix B for various types of sample log forms.
Managing the server

This chapter explains how to use different user accounts to perform system administration tasks. Three topics convey this information:

- Network considerations
- Windows user accounts
- Managing the server disk space

Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network considerations</td>
<td>2-2</td>
</tr>
<tr>
<td>Windows user accounts</td>
<td>2-3</td>
</tr>
<tr>
<td>Managing the server disk space</td>
<td>2-4</td>
</tr>
</tbody>
</table>
Network considerations

A domain-based network infrastructure is required for the Empower 2 Enterprise/Workgroup system. In addition, all Empower 2 related computers (clients, LAC/E acquisition servers, and servers) must be synchronized to a time server.

In a Windows 2000/Windows Server 2003-based domain, the domain controllers are automatically configured as time servers for the domain.

To maximize uptime and minimize issues related to the network environment, Waters recommends that you follow these guidelines:

- All Empower 2-related accounts, computer and user, should reside within the same domain.
- If you are using real-time virus scanning, exclude all Empower 2-related folders and their sub-directories. Some real-time virus scanners mistake normal Empower 2 software functionality for virus activity, causing data buffering problems.

With the release of Empower 2 software, acquisition servers are called Empower nodes. When you create an Empower node, you must specify the time zone for the node’s location.

Group Policy Objects

Group Policy Objects (GPOs) are used by system administrators to define and enforce settings in an active directory network. Administrators are able to apply settings to users and computers based on locally defined group and site membership criteria. Before defining GPOs in an Empower 2 network, keep in mind that Empower 2 software is a distributed chromatography data acquisition system that relies on remote access and DCOM to carry out its activities. Empower 2 software uses information stored in the database and in individual flat files, such as instsrv.dat (instrument configuration information) and nnnn.dat (actual raw data file) where nnnn is a channel ID number.

If GPOs are used in an Empower 2 network, Waters recommends that you follow these guidelines:

- Place Empower 2 nodes in their own Organization Unit (OU). Define GPOs for that OU, which minimizes allowable changes; for example, test
Microsoft hot fixes and service packs before applying them to the environment.

- Grant administrators full access to the registry and file system so that they can properly install software.
- Limit changes to the file system protections expected by the Empower 2 software.

GPOs may interfere with successful Empower 2 software operation. For example, data buffering may occur if the anonymous access to the raw data share is altered, or the editors for the COM instruments may not operate properly if the access control list for the HTML directories is altered.

### Windows user accounts

Windows user accounts allow access to various system functions. These user accounts can be local or domain. Local user accounts are created in the user management utility of the computer and cannot be used to log in to other computers. Domain user accounts are created in the user management utility of the domain controller. By default, domain users can log in to any computer that is a member of the same, or a trusted, domain.

These accounts permit access to the Windows operating system:

- Administrator accounts (local or domain)
- User accounts (local or domain)

Use an administrator account to log in to the Empower 2 Enterprise/Workgroup server when you need to perform system administration tasks.

### Windows administrator account privileges

The Windows 2000/Windows Server 2003 Administrator account includes all privileges on the server. With Administrator account privileges, you have full access to:

- All public, personal, and system files and directories
- Empower 2 database files
- Empower 2 raw data files
- All Windows 2000/Windows Server 2003 user accounts and account information on the local machine
For more information on Windows 2000/Windows Server 2003 server privileges, see the Windows Help and user documentation.

**Caution:** Use caution when you access the Windows 2000 or Windows Server 2003 server using an Administrator account. This account allows you unlimited access to the Empower 2 software and Windows files and directories on the server.

Use a regular user account to log in to the server when you are not performing system administration tasks.

**Windows domain user account privileges**

Use domain user accounts to log in to the operating system of Empower 2 clients. By default, domain users have limited access to local resources. When you install Empower 2 software on the client, domain users are given full control of Empower 2-related program files. If these permissions are modified, users may not be able to perform normal Empower 2 software functions, such as creating or modifying instrument methods or viewing data in Review.

**Managing the server disk space**

The operating system disk management Properties dialog box provides several tools to help manage disk space. This section covers the following topics:

- Checking the amount of free disk space
- Increasing free disk space
- Defragmenting the hard disk

**Checking free disk space**

To avoid hard disk problems, and to maintain server performance, limit server hard drive use to no more than 80% of full capacity. The Windows operating systems provide utilities such as Windows Explorer, System Tools, Disk Management, and the Windows Help to help you manage server disk space.

Use the following procedure to check the amount of free disk space on the server. In a standard configuration, disk space on the server is used mainly by raw data acquired with Empower 2 software. The size of raw data files created
in Empower 2 software is related to the sampling rate and the run time used to collect data. The database size also expands with usage.

In Empower 2 software, multiple raw data paths can be defined. It is therefore necessary to also check disk space on each drive where raw data files are being stored. See “Managing raw data files” on page 4-10, for more information.

Requirement: To avoid degradation in system performance, system administrators need to check available disk space regularly. On systems with heavy daily usage, check and record available disk space frequently. If your system is used less frequently, check and record disk space accordingly.

To check free disk space on the server
1. Right-click My Computer and then select Manage.
2. In the Computer Management window, click Storage > Disk Management.
3. Verify that there is available disk space and click OK.

Tip: There are also utilities available to monitor and alarm or send an e-mail when disk space reaches a user-defined size.

Increasing free disk space
You can increase free disk space the following ways:

- Archiving projects
- Adding a hard disk
- Moving project raw data to another file share, on a separate drive or server

Archiving projects
Archiving projects involves backing up projects, and then deleting the projects from the database.

For details, see the procedures on archiving projects in the Empower 2 online Help.

Waters offers several automated archive options for Empower 2 software. For more information, contact your local subsidiary or see www.Waters.com.
Adding a hard disk

Another way to increase free disk space is to add a hard disk to your Empower 2 system. For more information see the hardware documentation and the Windows documentation that accompany your server.

Moving project raw data

Moving your raw data storage location to another computer or drive on your network adds additional storage capacity. See “Managing raw data files” on page 4-10, for information on this procedure.

Defragmenting the hard disk

Hard disk fragmentation occurs when you delete files from a disk and then create or add new files on the same disk. Therefore, fragmentation inevitably occurs with system use. If left unchecked, disk fragmentation can slow system performance markedly. The Windows operating system contains a defragmenting utility. To access it, right-click My Computer and then select Manage. The Disk Defragmenter utility is located under the Storage node of Computer Management. For information on using this utility, see the Windows 2000 Help, Windows Server 2003 Help, Windows Vista Help, or Windows XP Help.
Managing the Empower 2 database

This chapter explains how to use the Oracle Enterprise Manager (OEM) Database Control console to manage the Empower 2 FR 5 database. These are the management tasks covered in this chapter:

- Accessing the OEM Database Control console
- Changing Oracle users’ default passwords
- Creating an additional database instance
- Managing Empower 2 database (Oracle) accounts
- Configuring the Windows DBA account
- Shutting down and starting up the Empower 2 database
- Database file organization
- Archiving alert logs
- Adding database data files

Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Enterprise Manager console</td>
<td>3-2</td>
</tr>
<tr>
<td>Recording database information</td>
<td>3-3</td>
</tr>
<tr>
<td>Creating an additional database instance</td>
<td>3-4</td>
</tr>
<tr>
<td>Managing Empower 2 database (Oracle) accounts</td>
<td>3-12</td>
</tr>
<tr>
<td>Shutting down and starting up the Empower 2 database</td>
<td>3-12</td>
</tr>
<tr>
<td>Configuring the Windows DBA account</td>
<td>3-13</td>
</tr>
<tr>
<td>Database file organization</td>
<td>3-18</td>
</tr>
<tr>
<td>Archiving alert logs</td>
<td>3-21</td>
</tr>
<tr>
<td>Adding datafiles to the database</td>
<td>3-21</td>
</tr>
</tbody>
</table>
Oracle Enterprise Manager console

The Empower 2 database is managed using the Oracle Enterprise Manager web interface, which allows you to perform database monitoring, administration, and maintenance tasks from a web browser.

Tip: For additional information on the Enterprise Manager, refer to the Oracle documentation on the Empower 2 FR 5 Oracle Documentation DVD.

Caution: Waters personnel tested the management tasks described in this chapter. If you perform additional database tuning, you might create or modify system objects that negatively affect Empower 2 software functionality, and you may need to revalidate Empower 2 software. Contact your Waters Data Specialist before implementing any database changes.

Accessing the OEM database control console

For the Windows Server 2003 with Enhanced Security enabled, the OEM database control console URL must be added as a trusted site if you do not want to modify your existing security settings.

To add the OEM database control console URL as a trusted site

1. Double-click Internet Explorer.
2. Click Tools > Internet Options.
3. In Internet Options, click Security.
4. On the Security tab, click Trusted sites, and then click Sites.
5. In the Trusted Sites dialog box, enter the URL for the database control, and then click Add. The URL is http://servername:port number/em where
   • servername is the hostname or the IP address of your database server.
   • port number is the port by which the console connects to Oracle. If there is a single Oracle 10.2.0.3 home with a single database instance on the server, the port number is typically 1158 or 5500. If there are additional database instances, their port numbers typically start at 5500 and increase by 1 for each additional instance (5500 for the second instance, 5501 for the third, etc.)
6. Click Close then OK to exit Internet Options.
To access the Oracle Enterprise Manager console

1. From Internet Explorer, enter the following URL: http://servername:1158/em (where servername is the hostname of your database server and 1158 is the port number if there is a single database instance).

   Tip: If you are currently logged into the Empower 2 database server, you can use the Empower 2 shortcut menu key. To access the Database Control Console, click Start > Programs > Empower > Enterprise Manager Web Console.

2. In the Oracle Enterprise Manager Login to Database: database name page, enter System in the User Name field and enter Empower (not case sensitive) in the Password field. Do not change Normal in the Connect As field, and then click Login.

3. In the Oracle Database 10g Licensing Information window, read the information and scroll to the bottom of the page, and then click I Agree.

The Home page of the Database Control console opens displaying the following information regarding the current status and configuration of the Empower 2 database:

- Database status, instance name, database version, and Oracle home location
- Server CPU statistics
- Space usage
- Outstanding alerts

For more information about the Database Control Console, see the “Oracle Database Home Page” topic in the Enterprise Manager Help.

To exit the Database Control console, click Logout.

Recording database information

As soon as your database is built, you should record the following information:

- Database unique name
- Database ID
- Location of the flash recovery area
To locate the Database unique name
1. Log in to the OEM web console, and then click the Administration tab.
2. In the Database Instance, under Database Configuration, click All Initialization Parameters.
3. In the Name filter field, enter DB_UNIQUE_NAME, and then click Go.

To locate the Database ID
1. In the Database Instance, under Storage, click Controlfiles.
2. Click Advanced, and look for the Database ID field.
   
   **Requirement:** Record this number, as you may need it if you have to restore the database.

To locate the flash recovery area (Solaris only)
1. In the Database Instance, under Database Configuration, click All Initialization Parameters.
2. In the Name filter field, enter db_recovery_file_dest, and then click Go.
   
   **Requirement:** Record the path indicated in the Value field, as you may need it if you have to restore the database.

Creating an additional database instance

You can create an additional database instance on a Windows-based Empower 2 database server. Creating an additional database instance lets you distribute additional users and systems and logically separate groups; such as, R&D from QC.

Preparing to create an additional database instance

Before you create an additional database instance on a Windows Empower 2 database server, complete these tasks to prepare the system and gather information you need to complete the process:

- Confirm that Oracle software is installed.
- Create an initial WATx Instance using the Waters Empower 2 Installer, as instructed in the Empower 2 Installation and Configuration Guide, Rev. B.
• Refer to this documentation as a guide when you create an additional database instance.

• If you want to create additional Empower 2 File Servers for one or more database instances, follow the instructions in the Empower 2 Installation and Configuration Guide, Rev. B.

• Plan your server and disk drive configurations.

**Planning server and disk drive configurations**

Confirm that your server has these capabilities:

• Sufficient memory to support additional database instances.
  
  **Tip:** Each instance running on a 32-bit Windows database server can access up to 3 GB of memory. After creating the additional instance, it can be necessary to either increase physical memory or reduce the amount of memory that one or more of the instances uses to process information.

• Sufficient number of disk drives to support multiple database instances.
  
The Empower 2 Installation and Configuration Guide, Rev. B specifies the disks listed in the table below, in addition to the system drive on which the operating system is installed and the paging file is typically stored.

  **Tip:** The term “drive” refers to an actual physical drive and not a partition created on a drive. Using partitions on the same physical drive is likely to degrade performance.

<table>
<thead>
<tr>
<th>Drive</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program drive</td>
<td>This drive can be shared between the instances. Only one copy each of the Empower 2 and Oracle program files exist. If multiple Oracle homes are created, then depending upon usage, they may need to be installed into separate drives.</td>
</tr>
<tr>
<td>Raw Data Drive</td>
<td>In a single instance system, this drive contains the raw data, one of two copies of the archive logs, the mirrored redo logs, and additional copies of the control files. At a minimum, have separate raw data drives available for each instance. Depending upon usage, it can be necessary to move either the archive logs or the redo logs onto a separate disk.</td>
</tr>
</tbody>
</table>
When planning disk drive configurations, the actual workload plays a significant role. Monitor disk drives (and other criteria) using Microsoft’s Perform utility or other suitable tool. This can help you identify any performance issues. Keep these considerations in mind:

- When designing database backups, do not backup the production version of the database, as doing so can damage it.

  **Recommendation:** Use Waters back-up scripts to safely create a copy of the database, and then use your back-up software to back up the copy.

  **Rule:** Do not use third-party Oracle agents to back up the database, as doing so violates Waters Software license.

- Waters recommends that you create additional listener processes, and then distribute connection requests among them.

### Creating an additional database instance

The process to create an additional database instance involves these tasks:

- Creating the initial database instance
- Creating a database template for an additional database instance
- Creating an additional database instance
- Creating Empower 2 structures in the new database instance
- Preparing the new database for use

#### To create an initial database instance

- Create an initial database instance following the instructions in the Empower 2 Installation and Configuration Guide, Rev. B.
- Use the forms in Appendix B to record the following information:

<table>
<thead>
<tr>
<th>Drive</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database drive</td>
<td>Waters recommends that separate database drives be available for each instance.</td>
</tr>
<tr>
<td>Backup drive</td>
<td>In a multiple instance system, have additional drives available for miscellaneous uses such as storing the hot and cold backups from each database.</td>
</tr>
</tbody>
</table>
To create a database template to use to create an additional database instance

1. Start the Oracle database Configuration Assistant, and then click Next. **Tip:** The Configuration Assistant consists of nine pages that step you through the process of creating an additional database instance. After completing the tasks on each page, click Next to advance to the next page.

2. On the Operations page - Step 1 of 9, select the Manage Templates option.

3. On the Template Management screen - Step 2 of 9, select “Create a database template” and “from an existing template” options, and then click Next.

4. On the Database Templates page - Step 3 of 9, select the “es” template.

5. On the Template Properties page - Step 4 of 9, type a name for the template and a brief description.


7. In the Value box on the File Location Variables page, enter locations for these variables, and confirm that they are not the same values as those
used for another instance. (Record this information on the forms at the end of this document.)

- DB_DIRECTORY
- DB_MIRROR
- DB_ARCHIVE
- DB_ARCHIVE2

**Tip:** You might want to include the SID in the path in order to distinguish the directory structures, as in this example:

For DB_DIRECTORY, enter Q:\WAT7\empowerdatabase


10. On each tab on the Initialization Parameters page – Step 8 of 9, modify the settings as described in this table, and then click Next:

**Initialization Parameters Settings**

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings</th>
</tr>
</thead>
</table>
| Memory    | Select “Typical – Allocate memory as a percentage of the total physical memory”, and enter a percentage value.  
**Recommendation:** Allocate a value of 35% to 40% for each instance. Do not accept the default value of 65%. Doing so can cause excessive use of memory resources, such as paging, which reduces performance. Balance the physical memory for each Empower 2 instance so that the server can access sufficient memory to perform all of its expected operations.  
**Tip:** After the database is in use, you might need to adjust this value later on. |
| Sizing    | Increase the value of the processes parameter, typically 600 or higher. Specifying too small of a number can prevent connections under heavy usage. Accept the 8 KB block size value. |
11. On the Database Storage page – Step 9 of 9, review the information that you provided previously within the steps of the Configuration Assistant.

**Tips:**
- If you need to change any information, you can do so on this page, or you can go back to the specific page in the Configuration Assistant that you want to change.
- If you want to add additional database data files, change the size of any database data files, add or change redo log groups, in the left pane, select that item in the tree that you want to add or change.

12. Click Finish to create the database template.

**To create an additional database instance using the newly created database template**

1. Start the Database Configuration Assistant.
2. On the DBCA Operations page, select the Create a Database option.
3. On the Database Template page, select the template you created previously.
4. On the Database Identification page, enter a global database name in the form of SID.ServerName.
   **Rule:** The name must be unique.
5. On the Management Options page, accept the default entries.
6. On the Database Credentials page, enter the appropriate passwords for the Oracle accounts, and then record them in a safe place.
7. On the next four pages: Storage Options, Database File Locations, Recovery Configuration, and Database Content, accept the default entries.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Character sets</td>
<td>Do not change the settings on this tab. The character set WE8ISO8559P1 is required for Empower 2.</td>
</tr>
<tr>
<td>Connection Mode</td>
<td>Accept the default setting of “Dedicated Server Mode”.</td>
</tr>
</tbody>
</table>
9. On the Initialization Parameters page, confirm or modify these settings, as described:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>Confirm that the memory allocation percentage is sufficient for available server resources, ensuring that the server memory usage is not excessive. (35% and 40% recommended.)&lt;br&gt;&lt;strong&gt;Rule:&lt;/strong&gt; Do not allocate all physical memory to Oracle.</td>
</tr>
<tr>
<td>Sizing</td>
<td>Confirm that the processes parameter is set at 500 or higher. Accept the block size value of 8 KB.</td>
</tr>
<tr>
<td>Character sets</td>
<td>Do not change the settings on this tab. The character set WE8ISO8559P1 is required for Empower 2 software.</td>
</tr>
<tr>
<td>Connection Mode</td>
<td>Accept the default setting of “Dedicated Server Mode”.</td>
</tr>
</tbody>
</table>

10. On the Database Storage page, confirm the information, and then record this information on the forms at the end of this document, or use the DBCA tool to capture the configuration.

11. On the Creation Options page, select the Generate Database Creation Scripts check box, record the location, and then click Finish.

12. On the Confirmation page, if you want to save this information as an HTML file, click Save as an HTML file, and then click OK.

13. When the Configuration Assistant displays a message indicating that the database was successfully completed, record the port number of the Enterprise Manager URL.

**Creating Empower 2 structures in the new database**

The Empower 2 structures already exist in the original database (typically WAT6). You need to create the Empower 2 structures in the new database (WAT7 in this example).

**To create Empower 2 structures in the new database**

1. Create a shortcut to the Enterprise manager for the additional database instance.
2. From the Empower menu, start the Enterprise Manager.

3. Specify the Enterprise Manager Port number that you recorded at the end of the database creation process, replacing the default value of 5500.

4. Save the current URL as a favorite in Internet Explorer.

5. Open a command prompt and run the following batch file, specifying the values for the parameters that you recorded at the end of this document, in the order listed below:

   **Batch file:** `x:\ empower\ script\ fillempowerdb.bat`

   **Parameters:**
   - SID
   - ORACLE_HOME
   - Drive letter where oracle is installed
   - PWD for Oracle System account

   **Example:** `fillempowerdb.bat WAT7 D:\ Empower\ Oracle\ Oracle10G D <password>`

**To confirm Empower 2 structures and prepare the database for use**

1. Using Enterprise Manager, confirm that 39 tables exist in the millennium schema.

2. Create net service names that point to each instance. (Refer to Empower 2 Installation and Configuration Guide, Rev B.)

3. Add the license disks for each instance. (Refer to Empower 2 Installation and Configuration Guide, Rev B.)

4. Log into each instance and set the raw data file locations. (Refer to Empower 2 Installation and Configuration Guide, Rev B.)

5. Restore the default projects.

6. Process data in each instance.

7. Acquire data into each instance.

8. Backup projects from each instance.
Managing Empower 2 database (Oracle) accounts

By default, there are two Oracle administrator accounts that you can use to manage the Empower 2 database via the OEM Database Control console:

- Sys
- System

Use the Oracle Sys account (user name = Sys, default password = oracle, connect as = SYSDBA) to log in to the Database Control Console when you want to use Oracle SYSDBA functions or commands such as changing the status of the database or editing non-dynamic database parameters.

Use the Oracle System account (user name = System, password = empower, connect as = normal) to log in to the Database Control Console when you want to perform DBA management functions, such as taking a tablespace online or offline, or adding a datafile to a tablespace.

Changing the Oracle user accounts passwords

Change the Oracle user account passwords the first time you log in and regularly thereafter to maintain system security.

Caution: Keep a record of the changed passwords and store it in a safe location. Waters cannot recover forgotten passwords.

To change the System or Sys account password

1. Log in to the Database Control Console using the Oracle account that you want to change.
2. Click Preferences in the upper right-hand corner of the browser window.
3. In the Preferences page, enter the new password in the Password field, and then retype it in the Confirm Password field.
4. Click Apply.

Shutting down and starting up the Empower 2 database

The Empower 2 database is set to start when you power-on the database server. For various reasons, it may be necessary to manually stop or restart the database. This section describes how to use the Database Control console
Configuring the Windows DBA account

The Windows user account must be added as a member of the ORA_DBA group. When the user is already a member of a domain group, such as Server Operators, the group can be added as a member of the ORA_DBA group. For Windows 2000/Windows Server 2003 servers, the local and domain administrators are automatically added as members of the ORA_DBA group. If you want to give a different user (or group) ORA_DBA privileges, follow the procedures in “Adding a user or group to the ORA_DBA group”.

Adding a user or group to the ORA_DBA group

To add a user or group to the ORA_DBA group, follow one of these procedures depending on whether the Empower 2 database server is a domain member or a domain controller.

Empower 2 Database server as domain member

To add a user group to the ORA_DBA group

1. Go to Start > Programs > Administrative Tools > Computer Management.
2. In Computer Management, browse to System Tools > Local Users and Groups > Groups.
3. In the right-hand pane, double-click ORA_DBA.
4. Take one of the following actions if the administrator account you will be using to manage the database is not already listed as a member:
   • In the Select Users or Groups dialog box, click Locations. In the Locations dialog box, if you are adding a preconfigured local user to the group, select the Empower 2 database server name. If you are adding a domain user or group, select the appropriate domain.
**Requirement:** To select a domain user or group, you must have access to the domain administrator username/password. If you want to select a user account on the local server, click Cancel when prompted for domain credentials, and then select the database server name from the Locations dialog box.

- In the Select Users or Groups dialog box, enter the name for the user or group whose credentials will be used for database management functions, and then click OK.

**Empower 2 Database Server as domain controller**

**Tip:** By default, Empower 2 Workgroup servers configured by Waters are domain controllers.

**To add a user group to the ORA_DBA group**

1. Go to Start > Programs > Administrative Tools > Active Directory Users and Computers.
2. Click Users.
4. In the right-hand pane, double-click ORA_DBA.
5. In the ORA_DBA properties, click the Members tab.
6. Take one of the following actions if the administrator account you will be using to manage the database is not already listed as a member:
   - In the Members tab, click Add.
   - In the Select User, Computers or Groups dialog box, verify that the appropriate domain name displays in the Look in field.
   - Enter the name of the domain user or group whose credentials will be used for database management functions, and then click OK.

**Granting the Windows DBA user batch job privileges**

**To grant the Windows DBA user the privilege to log on as batch job**

1. Click Start > Programs > Administrative Tools > Local Security Policy.

**Alternative:** On Domain controllers, click Start > Programs > Administrative Tools > Domain Controller Security Policy.
2. Expand the Local Policies, click User Rights Assignments, scroll down the Policy list, and then select Log on as a batch job.

3. Double-click Policy Log on as a batch job.

4. In the Policy Setting dialog box, click Add.

5. In the Select Users or Groups dialog box, click Locations.
   
   **Tip:** If you are adding an existing local user to the group, select the name of the Empower 2 database server. If you are adding a domain user or group, select the appropriate domain.

   **Requirement:** To select a domain user or group, you must have access to the domain administrator username and password. If you want to select a user account on the local server, click Cancel when prompted for domain credentials, and then select the database server name from the Locations dialog box.

6. Enter the name for the user or group whose credentials will be used for database management functions, and then click OK.

**Shutting down the Empower 2 database**

You may need to shut down the Empower 2 database for various reasons, such as before performing a backup of the entire server or before performing server maintenance. Before shutting down the database, you might want to use System Monitor to confirm that no users are currently connected to the database. To start System Monitor, log in to Empower 2 software and select View > System Monitor from the Configuration Manager window.

**To manually shut down the Empower 2 database**

1. Log in to the Database Control console as the Oracle sys user with SYSDBA privileges.

2. Click Shutdown.

3. In the Startup/Shutdown window: Specify Host and Target Database Credentials page, do the following and then click OK.
   
   • In Host Credentials, enter the username and password for the Windows user who is a member of the ORA_DBA group configured according to the procedure in “Configuring the Windows DBA account”.

*Configuring the Windows DBA account* 3-15
In the Database Credentials, enter the username and password for the Oracle sys user, and then select SYSDBA from the Connect As list.

4. In the Startup/Shutdown Confirmation page, click Yes to perform a shutdown immediate and continue with step 7.

   Alternative: To view other shutdown options, click Advanced Options and continue with step 5.

5. In the Startup/Shutdown Advanced Options page, select the type of shutdown to perform, and then click OK.

6. In the Startup/Shutdown confirmation page, click Yes to initiate the database shutdown.

7. The Startup/Shutdown: Database Activity page appears. Click Refresh to return to the Database Control console home page.

8. Click Logout to exit the Database Control console.

   Tip: If you restart the server, the database will automatically attempt to start, unless the OracleWATnService service is reset to Startup Type Manual or Disabled.

**Shutting down when OEM is inaccessible**

If the database is in need of recovery, it may not be possible to shut it down using the Database Control console.

**To perform a database shutdown when OEM is inaccessible**

1. Click Start > Programs > Administrative Tools > Computer Management.

2. In Computer Manager, expand Services, and then scroll down the list of services to OracleWATnService.

3. Right-click OracleWATnService, and then select Properties.

4. Click Stop.
5. If the service does not stop, or if you want to ensure that the database does not attempt to start automatically when the server is restarted, change the Startup Type to Disabled, and then restart the server.

**Requirement:** When you are finished maintaining the database or server, you must reset the Startup Type of the OracleWATnService to Automatic.

### Starting up the Empower 2 database

For various reasons, the Empower 2 database might need to be started manually. For example, the database needs to be manually started to perform database recovery or if it fails to start when the server is rebooted.

#### To manually start the Empower 2 database

1. Access the Database Control console. The Database home page will display a message stating that the database is currently unavailable.
2. Click the Startup button.
3. In the Startup/Shutdown: Specify Host and Target Database Credentials page, perform these actions, and then click OK.
   - Under Host Credentials, enter the username and password for the Windows user who is a member of the ORA_DBA group configured according to the procedure in “Configuring the Windows DBA account”.
   - Under Database Credentials, enter the username and password for the Oracle sys user, and then select SYSDBA from the Connect As list.
4. In the Startup/Shutdown Advanced Startup Options page, select the appropriate startup options, and then click OK.
5. In the Startup/Shutdown Confirmation page, click Yes to initiate the database startup.

**Result:** When the database startup is complete, the Database Control console login page appears.
Database file organization

This section describes the organization of the Empower 2 server and discusses server hard drives and database file organization.

Server configurations

The default configuration of the Empower 2 server uses four large-capacity hard drives that are partitioned into four logical drives for storing:

- The Windows operating system
- Oracle program files, Empower 2 client stack, and Empower 2 program files
- The Empower 2 database data files
- Empower 2 raw data files

Database file organization

For detailed information on defining the basic database structure, see the Empower 2 System Installation and Configuration Guide, Rev. B. The spfile and other parameters used during instance creation define the Empower 2 database. For performance and reliability reasons, the Oracle archive logs, mirrored control files, and mirrored redo logs are usually located on different physical disks. These locations are defined when Empower 2 software is installed.

Tip: The location of your Empower 2 database files depends on the locations you selected when you installed the database.

For detailed information on the Oracle database files, see the Oracle 10g Database Concepts Manual and the Empower 2 System Installation and Configuration Guide, Rev. B.

The Empower 2 database files are organized by default as shown in the following table. The specified locations assume a standard installation of Empower Enterprise to the recommended locations on a server with 4 physical drives. The file names and locations further assume that the default SID—WAT6— is selected during installation (if not, replace all occurrences of WAT6 in the table with your SID).
### Empower 2 default file organization

<table>
<thead>
<tr>
<th>Drive</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>program-drive\Empower\Bin</td>
<td>The Empower software executable files.</td>
</tr>
<tr>
<td>program-drive\Empower\Scripts</td>
<td>The Empower 2 software scripts which includes the hot and cold backup script files.</td>
</tr>
<tr>
<td>program-drive\Empower\Oracle\admin\WAT6\bdump</td>
<td>The Oracle alert log which contains information regarding database activity.</td>
</tr>
<tr>
<td>program-drive\Empower\Oracle\Oracle10g\Bin</td>
<td>The Oracle software executable files.</td>
</tr>
<tr>
<td>program-drive\Empower\Oracle\Oracle10g\Database</td>
<td>pwdWAT6.ora file is the Oracle (not Empower) password. SPFILEWAT6.ora is the server parameter file. <strong>Restriction:</strong> Do not edit the SpfileWAT6.ora file.</td>
</tr>
<tr>
<td>program-drive\Empower\Oracle\Oracle10g\Network\Admin</td>
<td>tnsnames.ora contains the connect information for the Empower 2 database.</td>
</tr>
<tr>
<td>program-drive\Empower\Oracle\Oracle10g\Network\Admin\Log</td>
<td>Listener.log contains information about database connections.</td>
</tr>
<tr>
<td>program-drive\EmpowerArchive2DB</td>
<td>One set of mirrored archive logs used for database recovery.</td>
</tr>
</tbody>
</table>
## Empower 2 default file organization (Continued)

<table>
<thead>
<tr>
<th>Drive</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>database-drive\EmpowerDatabase\oradata\WAT6</td>
<td>• INDEX01.DBF – The index tablespace datafile.</td>
</tr>
<tr>
<td></td>
<td>• TEMP01.DBF – The temporary tablespace datafile.</td>
</tr>
<tr>
<td></td>
<td>• SYSTEM01.DBF – The system tablespace datafile.</td>
</tr>
<tr>
<td></td>
<td>• UndoTBS01.DBF – The undo tablespace datafile.</td>
</tr>
<tr>
<td></td>
<td>• SYSAUX01.DBF – The sys aux tablespace datafile.</td>
</tr>
<tr>
<td></td>
<td>• USERS01.DBF – The user tablespace datafile.</td>
</tr>
<tr>
<td></td>
<td>• CONTROL01.CTL – One copy of the database controlfile.</td>
</tr>
<tr>
<td></td>
<td>• REDO0N.log – The redo logs (where n is 1 to 4).</td>
</tr>
</tbody>
</table>

| rawdata-drive\Empower\Projects             | This is the default raw data location. This directory will contain a sub-directory for each project in the database. |
|                                            | **Tip:** The project folder names viewed in this directory do not always exactly match the project names displayed in Configuration Manager when projects are part of a project hierarchy. |

| rawdata-drive\EmpowerArchive1DB            | Set of mirrored archive logs.                                         |

| rawdata-drive\EmpowerMirrorDB\oradata\WAT6 | Control0n.ctl are mirrored copies of the database control files (where n equals 2 to 3). |
|                                            | Redo20n.log are mirrored copies of the redo logs (where n equals 1 to 4). |
Archiving alert logs

The Oracle alert log is a file that Oracle uses to log important database information. The file continually grows larger, and if it becomes too large, it can adversely affect system performance. You should archive the alert log on a regular basis so that it does not become so large as to cause problems.

To archive the alert log, move it from program-drive\Empower\Oracle\Admin\WAT6\bdump to your storage location, i.e., G:\Backup.

Tip: After the alert log is moved, a new one will be recreated automatically.

Adding datafiles to the database

To add additional datafiles to a database tablespace

1. Using the System account, log in to the Database Control console.
2. Click Administration, and then click Datafiles in the Storage column.
3. In the Datafiles page, select the appropriate file. For example, to create an additional data file in the USER_DATA tablespace (where the majority of Empower 2 related database information is stored), select:
   driveletter:EMPOWERDATABASE\ORADATA\WAT6\USERS01.DBF
4. Ensure Create Like is selected in the Action box, and then click Go.
5. In the Create Datafile page, do the following, and then click OK:
   - Enter the desired datafile name.
   - Enter the directory path for the new datafile.
   Requirement: The specified path must already exist. Otherwise the datafile creation will fail.
   - Verify that the correct tablespace is entered.
   - Clear Reuse Existing File.
   Result: The datafile will be created and the Datafiles page will reappear. The new datafile will be listed in the Results table.
Managing Empower 2 software

This chapter explains how to manage Empower 2 software.

**Caution:** If you are logged in to Empower 2 software and then you log out and leave some of its applications running (such as Configuration Manager), a Running Empower Applications message box appears. This message box reminds you that the applications remain open and offers the option of leaving them in a locked or unlocked state. If you leave them in an unlocked state, a user without the required access privileges can log in and use the open applications as if he or she were you, assuming your access privileges, regardless of whether his or her user type grants those privileges.

When performing administrative tasks on a client, use the Empower 2 Pro interface.

**Contents**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the TNS_Admin environment variable</td>
<td>4-2</td>
</tr>
<tr>
<td>Defining net service names (database aliases)</td>
<td>4-4</td>
</tr>
<tr>
<td>Logging in to Empower 2 as the default system administrator</td>
<td>4-5</td>
</tr>
<tr>
<td>Managing project hierarchies</td>
<td>4-7</td>
</tr>
<tr>
<td>Managing raw data files</td>
<td>4-10</td>
</tr>
<tr>
<td>Using the System Monitor</td>
<td>4-12</td>
</tr>
<tr>
<td>Checking for Empower 2 service packs or feature releases</td>
<td>4-12</td>
</tr>
<tr>
<td>New administrative functions in Empower 2</td>
<td>4-13</td>
</tr>
<tr>
<td>Empower 2 Feature Release 5 Administrative features</td>
<td>4-21</td>
</tr>
</tbody>
</table>
Scope

When you manage Empower 2 software, you must perform the following tasks:

- Configuring a TNS_Admin variable
- Defining list of database aliases (net service names)
- Logging in to Empower 2 software as a default system administrator
- Changing Empower 2 system and account passwords
- Managing raw data files
- Using System Monitor
- Checking for Empower 2 software service packs
- Performing new Empower 2 administrator tasks

Using the TNS_Admin environment variable

The Empower 2 client and LAC/E acquisition server installer can create an environment variable, TNS_ADMIN, the value for which is the path to the shared folder containing a preconfigured tnsnames.ora file. Using this variable on clients and LAC/E acquisition servers removes the need to manually configure and maintain individual tnsnames.ora files on each computer. If you use this feature, be sure to place the tnsnames.ora file in a share on a server that yours users can access to log in to Empower 2 software.

Exception: If a network cable is removed while a LAC/E acquisition server is acquiring data, you must use a local tnsnames file, and then upload the sample set data to recover the interrupted data.

Recommendation: Locate the shared tnsnames.ora file in the \Empower\Projects directory, because that folder is shared with the appropriate security settings applied and must be available for normal Empower 2 software functionality.

Modifying the local security policy configuration on Windows Server 2003

If the TNS_ADMIN environmental variable is used to access an Empower 2 database on a Windows 2003 server, you must modify the configuration of the
default local security policy (or, for a domain controller, the domain controller
security policy) on the database server as follows to ensure proper Empower 2
software performance.

To modify the security policy configuration

1. Log on to the Empower 2 database server as an administrator.
   Alternative: For a Windows Server 2003 domain controller, access
   Administrative Tools > Domain Controller Security Policy.
3. In the left hand tree, click Security Settings.
4. Double-click the policy “Network Access: Allow Everyone permissions to
   apply to Anonymous”, and then select Enabled.
5. Click Apply, and then click OK.

Configuring a shared tnsnames.ora file

To configure a shared tnsnames.ora file

1. On the Empower 2 database server, locate the drive installed with the
   Oracle program files, and browse to the
   Empower\Oracle\Oracle10g\Network\Admin directory.
2. Locate the tnsnames.ora file, right-click the file, and then click Copy.
   Requirement: If you have multiple Empower 2 Database servers, add
   them to the tnsnames.ora file using the Net Configuration Assistant
   prior to copying the tnsnames.ora file.
3. Browse to the raw data drive\Empower\Projects directory, and paste
   the tnsnames.ora file into the folder.
   Recommendation: Waters recommends that the share be placed in the
   same directory that will hold Empower 2 raw data. Custom directories
   may be used, but if so, the share permissions must be set exactly as
   described in the Empower 2 Installation and Configuration Guide.
Defining net service names (database aliases)

When a net service name is configured using Oracle Net Configuration Assistant, the TNSNames.ora file is modified to contain the net service name information. Normally, this file is then parsed for all connect strings containing a SID name starting with WAT and these entries are used to populate the database list in the Empower Login dialog box. Another way to populate this field is by using a WatNames.ora file, which lets you to define the entries in the database list by using a simple text file. This is useful when you are using different Oracle applications and the TNSNames.ora file has grown fairly large. However, the use of a WatNames.ora file is optional. When using a WatNames.ora file, all names in the file still need to be resolved by TNSNames.ora or some other naming service.

To edit WatNames.ora

1. In Windows Explorer, right-click the WatNames.ora file and click Open With. By default, its location is program-drive\Empower\Script.

2. In the Open With dialog box, select Notepad, and then click OK. Notepad opens and displays an empty WatNames.ora file.

3. Enter a list containing your servers.

   **Tip:** If the WatNames.ora file is not already in program-drive\Empower\Script, use Notepad to create it.

Sample WatNames.ora File

4. Select File > Save, and then File > Exit.
Special considerations for Empower 2 Personal clients

If you are using Empower 2 Personal workstation as a client and you are using a naming service other than Local, use this procedure to force the use of the WatNames.ora file.

To configure the use of a WatNames.ora file

1. Select Start > Run. In the Run dialog box, enter regedit and click OK.
2. In the left pane of the Registry Editor window, locate HKEY_LOCAL_MACHINE\Software\Waters\Empower and ensure that Empower is selected.
4. In the right pane, a new value appears. Name the string WatNamesOnly.
5. Right-click WatNamesOnly, and then select Modify.
6. In the Edit String dialog box, enter TRUE in the Value Data field, and then click OK.
7. In the left pane, ensure that Empower is selected.
8. Select Edit > New > String Value.
9. When a new value appears in the right pane, name the string WatNamesLocation.
10. Right-click WatNamesLocation, and then select Modify.
11. In the Edit String dialog box, enter the location of the WatNames.ora file in the Value Data field, and then click OK.
   Example: D:\Empower\Script.

Logging in to Empower 2 as the default system administrator

Empower 2 comes with a default System user account which does not require a named user license. This Administrator account can be disabled but not removed from Empower 2.
To log in as the default system administrator

1. Select Start > Programs > Empower > Empower Login.
2. In the Empower Login dialog box, enter System as your user name and Manager as your password.
3. Select the net service name (database alias) for your Empower server.
4. Click Advanced and verify that the Requested Interface field is set to Pro.
   **Requirement**: If you do not have access to the Pro interface, you must log in with a different user account or modify the user properties of the current user account. See the Empower 2 online Help for more information.
5. Click OK. The Empower Pro window appears with the name of the database and the logged-in user displayed.

Changing the Empower 2 system user account password

Change the Empower 2 system user account password the first time you log in and regularly thereafter to maintain system security

To change the System account password

1. In Configuration Manager, select the Users view. In the right pane, select System.
2. Right-click System, and then select Properties. In the General tab, enter the new password in the New Password and Confirm New Password fields. Click OK.
   **Requirement**: You must be logged in as an Administrator to perform this procedure.

Changing the Empower 2 database password

The Empower 2 software uses the database password to access the database. Waters recommends that you do not change this password unless the security protocol of your company requires this.

**Recommendation**: Waters recommends that you do not change the internal password that the Empower 2 software uses to log in to the Oracle database. If
your company policy requires you to change this password, be certain to change it properly from the Configuration Manager window.

**Restriction:** Do not change this password directly in Oracle. Follow the procedure “To change the Empower 2 Oracle database password” exactly as it is written.

**To change the Empower 2 Oracle database password**

1. Save any unsaved results.
2. Close all open applications except Configuration Manager and the Empower Pro window.
3. In Configuration Manager, select View > Database Properties.
4. In the Database Properties dialog box, click Change Database Password.
5. In the Change Password dialog box, enter the old password, the new password, confirm the new password by retyping it, and then click OK twice.

**Managing project hierarchies**

You can create projects and sub-projects within a hierarchical structure to manage them individually and/or as a unit. When creating a project you determine whether it should be created at the project root directory (a top-level project), or in a project hierarchy as a sub-project to a parent project. This hierarchical structure allows you to easily organize multiple projects into one common project structure.

You can create new project hierarchies from existing projects whether they exist in a hierarchical or flat file structure. To do so, perform these tasks:

- Backup up the projects that you want to copy using the Backup Project Wizard.
- In Explorer, re-arrange the project directories to reflect the new hierarchical structure.
- Restore the projects with the new hierarchical structure using the Restore Project Wizard. When restoring a sub-project or hierarchy, the project restores to the parent project directory selected in the Restore Project wizard.
When the projects are restored in Configuration Manager, they will be organized according to a new hierarchical structure.

**Benefits of the hierarchical structure**

These are some benefits of a project's hierarchical structure:

- You can create copies of (clone) one or more projects when you want to use the information stored in projects as a building block for other projects. When you clone projects, their hierarchical structure is copied.

- You can move the raw data files for projects in one step and maintain its hierarchical structure.

- You can specify that users see only part of the project hierarchical structure that they can access, which makes it easier for them to locate and work on their projects.

**Project hierarchical structure example**

You can create monthly projects based on product, location, and lab. The following figure shows one way to organize project data by month for different groups and purposes. The project hierarchical structure is displayed in Configuration Manager.
Keep these items in mind when working with project hierarchies:

- An Empower 2 sub-project is the same as a regular Empower 2 project, the only difference is that it has another project as a parent.
- Sub-projects can include other sub-projects.
- Sub-projects within a hierarchy can have unique user access privileges and other settings. For example, you can grant users access to specific sub-projects, but not the parent project.
- When backing up a parent project and its sub-projects, the hierarchical structure remains intact.
- When using AutoArchive to archive a project hierarchy, the projects are archived in a flat structure and the hierarchical structure is lost.
- You can copy data and settings from a project to sub-projects.
- Deleting a project with sub-projects deletes both the parent project and sub-projects.
Managing raw data files

The Manage Raw Data Files capability allows you to configure additional paths on your system in which to store raw data on a per-project basis. By default, project raw data files are stored in the rawdata-drive\Empower\Projects directory; however, you can specify any valid share on your network. The specified directory does not have to reside on an Empower 2 server, although the WatersService service must be running on the computer where the path is located. For information on installing the WatersService service, see “Installing a File Server” in the Empower 2 Installation and Configuration Guide, Rev. B.

Adding a raw data share

To add a raw data share

1. In Configuration Manager, select View > Manage Raw Data Files.
2. In the Manage Raw Data Files dialog box, select the name of the file service running on the computer on which you want to store your data from the File Service list.
3. Click Add Raw Data Share.
4. In the Add Raw Data Share dialog box, enter the share name and click OK. If the share does not already exist, a dialog box appears allowing you to specify the directory path for the share.

When the share is created, the default permissions are applied. The permissions vary depending on operating systems. To ensure proper functionality and security, the permissions on the raw data folder must exactly be set as described in the Empower 2 Installation and Configuration Guide, Rev. B.

When creating a new project, you can specify the raw data path the project should use to store its raw data in the Name Entry page of the New Project Wizard. Existing project data can also be moved to a different raw data share. The three Empower 2 software privileges associated with this capability are Create Project Path, Specify Project Path, and Change Project Path. Users must have the appropriate privilege to use the different aspects of this feature.
**Exception:** If a raw data path that is being used by a project(s) is removed, the path no longer appears on the list in the Manage Raw Data Files dialog box; however, the path is still active in that both existing and newly acquired data continue to reside in that project’s path.

**Moving project raw data files**

You can move project raw data to a new data directory. To do so, in Configuration Manager, right-click the project and select Move Project Data. For more information, see the Empower 2 online Help.

**Recommendation:** It is not recommended to move the project data of projects containing large amounts of data using the Move Data Project utility. Change the raw path using Move Project Data and then manually move the files using operating system commands or with a backup utility.

**Viewing the current raw data paths**

By default, the directories containing project raw data are not displayed in the Configuration Manager Projects table. You can add this information to the table by creating a view filter.

**To display the current raw data paths for projects**

1. Log in to Empower 2 software as an Administrator user.
2. In Configuration Manager, click Projects.
3. To open the View Filter Editor, click Edit View.
4. Add Directory to the list of display fields.

   **Requirement:** Ensure that the Name field is the first field in the list.

5. Save the view filter, and then exit the View Filter Editor. The Directory field displays the current raw data paths for projects.
Using the System Monitor

The System Monitor application allows you to monitor system database usage. Information such as which users are accessing which projects, systems, and processing servers is displayed in table form. The following four views are available:

- Users
- Systems
- Projects
- Processing Servers

To access System Monitor, select View > System Monitor from the Configuration Manager window.

For more information on System Monitor, see the Empower 2 online Help.

Checking for Empower 2 service packs or feature releases

Waters periodically releases service packs or feature releases to address existing issues or to provide enhanced functionality. These service packs are available for download from the Waters Elite web site and should be installed according to the instructions contained in their respective release notes. For those customers who require physical media, note the part number from the web site and contact your local subsidiary to place an order.
## New administrative functions in Empower 2

Following is a partial list of Empower 2 administrative functions. All of these functions are described in the “What's new in this release of Empower” online Help topic.

### Empower 2 software Administrative functions

<table>
<thead>
<tr>
<th>New feature/Enhancement</th>
<th>Description</th>
</tr>
</thead>
</table>
| Additional system policies | Empower 2 software automatically generates secure and time-stamped audit trails that track any user who performs system-level activities identified as system objects. The system administrator can specify whether users must enter a comment and/or their Empower 2 password whenever they create modify, or delete one of these system objects. Additional system policies provide the ability to perform these tasks:  
  - Specify whether a user who signs off more than once on a result can state the same reason for each sign off.  
  - Designate that the person who performs the first sign off cannot be the same as the person who performs the second sign off.  
  - Set the universal time stamp configurations, such as regional time zone names, abbreviations for time zones, and whether you want to use the abbreviated or full region name when the time zone information is displayed.  
  - Disable the ability for a user to annotate a report while working in the Preview window. |
You can now perform the following operations on custom fields:

- Lock and unlock custom fields when assigned these privileges.
- Program custom fields to only calculate on a specific Sample Type (All, Standards only, Unknowns only, Standards and Unknowns, Standards and Controls, Unknown and Controls) and a Peak Type (Founds only, Unknowns only, Groups only, Founds and Groups, Unknowns and Groups).
- Specify that the enumerated field be a user-define field or an actual field value. For example, you can use Peak Field to calculate translation values, such as not applicable or as the actual value of a field (area%).
- Use calibration curve fields in formula calculations.
- Use inter-sample custom fields with System Suitability, such as calculating the %RSD and summarize these fields in the Run Samples list. You can use faulted intersample files in summary reports and to re-inject samples in a sample set.

<table>
<thead>
<tr>
<th>New feature/Enhancement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom fields</td>
<td>You can now perform the following operations on custom fields:</td>
</tr>
<tr>
<td></td>
<td>- Lock and unlock custom fields when assigned these privileges.</td>
</tr>
<tr>
<td></td>
<td>- Program custom fields to only calculate on a specific Sample Type (All, Standards only, Unknowns only, Standards and Unknowns, Standards and Controls, Unknown and Controls) and a Peak Type (Founds only, Unknowns only, Groups only, Founds and Groups, Unknowns and Groups).</td>
</tr>
<tr>
<td></td>
<td>- Specify that the enumerated field be a user-define field or an actual field value. For example, you can use Peak Field to calculate translation values, such as not applicable or as the actual value of a field (area%).</td>
</tr>
<tr>
<td></td>
<td>- Use calibration curve fields in formula calculations.</td>
</tr>
<tr>
<td></td>
<td>- Use inter-sample custom fields with System Suitability, such as calculating the %RSD and summarize these fields in the Run Samples list. You can use faulted intersample files in summary reports and to re-inject samples in a sample set.</td>
</tr>
<tr>
<td>Database ID</td>
<td>The database ID is listed in both the system and project audit trail. If you imported system or project objects from another database, the system and project trail records the unique database ID. In addition the help about dialog box displays the ID of the database.</td>
</tr>
</tbody>
</table>
## Empower 2 software Administrative functions (Continued)

<table>
<thead>
<tr>
<th>New feature/Enhancement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pro Login window</strong></td>
<td>If the system policy is set to suspend operation of Empower 2 software when it is inactive for ( x ) number of minutes, the time-out does not affect the Empower Pro Login window and you can still log on to the software.</td>
</tr>
</tbody>
</table>
| **Project audit trail**       | Users can be required to provide comments whenever they perform one of these tasks:  
  - Start a sample set  
  - Alter a running sample set  
  - Abort a sample set  
  - Start batch processing  
  - Perform MS calibrations  
  - Perform MS tunes  
  In addition, System Administrators can also specify whether a comment and/or password is required for every audit trail object. If the system policy is set to allow you to override the full audit trail setting for each new project, you can decide when you create a new project whether a comment and/or password is required for changes or deletions to samples, methods, or results. |
| **Result sign off in Preview**| If the system policy is set to log off users when they the system is inactive for \( x \) minutes, and if users leave the Sign Off Results dialog box open with their user name and password in it, and the time specified in the Sign Off Inactivity Delay text box elapses without any activity (typing in the password box), the Sign Off Results dialog box closes in Preview window. To sign off results, they must reopen the Sign Off Result dialog box, and enter their user names and passwords again, but they do not have to regenerate the report. |
### Empower 2 software Administrative functions (Continued)

<table>
<thead>
<tr>
<th>New feature/Enhancement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shallow copy of methods between FAT</td>
<td>You can copy only the current version of a method between full audit trail projects. To paste shallow-copied files into a full audit trail project, the Allow Shallow Copies Between FAT Projects system policy must be enabled.</td>
</tr>
<tr>
<td>User type privileges</td>
<td>The Modify Report Scaling Only privilege was modified so that you can edit the Scaling tab for plots, and then preview/print the report from Report Publisher. You cannot override the method.</td>
</tr>
</tbody>
</table>
### Empower 2 software Administrative functions (Continued)

<table>
<thead>
<tr>
<th>New feature/Enhancement</th>
<th>Description</th>
</tr>
</thead>
</table>
| Additional user type privileges | - There are several new privileges in Empower 2 software including:  
  - **Allow Calibration and Quantitation in Review (Management tab)**. This privilege allows you to calibrate and quantitate data in Review or QuickStart. Without this privilege, you cannot quantitate data.  
  - **View Quantitation Peak Fields in Review (Management tab)**. This privilege allows you to hide all columns in Review, with the exception of the peak, retention time, and custom fields. It prevents manual integration of peak areas for Quantitation and allows only batch processing.  
  - **Verify Incomplete Raw Data Files (Data Acquisition tab)**. This privilege allows you to accept or reject an incomplete raw data file in Review. When you open an incomplete raw data file in Review, you can right-click > Verify Missing data and choose to verify, accept, or reject the incomplete data file. If accepted, the data file is saved in its entirety.  
  - **Modify Component Constants/Default Amounts (Methods tab)**. This privilege enables you to open existing methods, change the 7 CConst fields in the Component tab and in the Slicing tab (GPC), and then save (or save as) the method when you do not have the Save Processing Method privilege. |
### Empower 2 software Administrative functions (Continued)

<table>
<thead>
<tr>
<th>New feature/Enhancement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email messages and email center</td>
<td>For Empower Enterprise/Workgroup configurations, you can configure an email center client for your company or corporation. The Waters Email Center sends outgoing email messages from the Message Center to a designated recipient. The email center facilitates troubleshooting because it allows the recipient to quickly respond to an Empower error without the need to check the Message Center throughout the day.</td>
</tr>
<tr>
<td>Empower nodes</td>
<td>Acquisition servers are now called Empower Nodes. When you create an Empower Node, you must now specify the time zone for the location of the Empower Node. Empower now records the date and time of data acquisition for different countries and time zones. In Configuration Manager &gt; Empower Nodes &gt; Empower Nodes table, Citrix® clients appear in the table with “Citrix” for their Empower Nodes type.</td>
</tr>
<tr>
<td>Maximum table row specification</td>
<td>In the tables view of the Configuration Manager and Project window, you can set the maximum rows of data to be displayed at one time. By using the paging buttons that are located at the top of the window, you can easily view table data. This feature also works with view filters.</td>
</tr>
</tbody>
</table>
### New feature/Enhancement

<table>
<thead>
<tr>
<th>New feature/Enhancement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Multiple user types</strong></td>
<td>You can assign individual users to more than one user type, as some users often perform more than one job function. If, for example, a chemist is also the System Administrator, you can assign him or her two user types: Chemist and Administrator. Users assigned to more than one user type can sign onto the system only as one user type at one time and perform only those functions associated with that user type. A user's user type appears in the system audit trail.</td>
</tr>
<tr>
<td><strong>NuGenesis SDMS</strong></td>
<td>Closer integration with SDMS enables you to automatically archive projects when they are deleted. SDMS archiving is managed through Empower 2 software. You can archive an EMF of the report after sign off.</td>
</tr>
<tr>
<td><strong>Project integrity</strong></td>
<td>When projects are backed up or restored, they pass through an integrity check that verifies the integrity of the database export files and the project raw data files. The results of the integrity checks are recorded in the system audit trial. You can access the project integrity report in Configuration Manager &gt; Projects &gt; select a project &gt; right-click Properties &gt; Project Properties dialog box.</td>
</tr>
<tr>
<td><strong>Export to text</strong></td>
<td>You can export these system objects to a text file in Notepad: Users, User Groups, User Types, Plate Types, Empower Nodes, and Chromatographic Systems.</td>
</tr>
<tr>
<td>New feature/Enhancement</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Additional project locking capabilities</td>
<td>With the correct privileges, you can lock a project and assign it to read-only or process-only access. If you open a locked project with read-only or process-only access, your displayed user type within the project is read-only or process-only, regardless of the user type you used when you logged in to Empower 2 software.</td>
</tr>
<tr>
<td>Time zones</td>
<td>Time zones are controlled by both a user type privilege and a system policy. Whenever data is acquired, processed, or reported, the time stamp will include the time zone based on the location of clients, workstations, LAC/E acquisition servers, or servers.</td>
</tr>
</tbody>
</table>
Empower 2 Feature Release 5 Administrative features

All of the Feature Release 5 administrative features are described in the following table as well as Empower 2 online Help.

Empower 2 FR 5 Administrative functions

<table>
<thead>
<tr>
<th>FR5 feature</th>
<th>Description</th>
</tr>
</thead>
</table>
| LDAP Authentication  | You can control the way users authenticate themselves when they log on to Empower software, sign off on a result, or reenable a locked session by selecting an authentication type: LDAP Authentication or Local Authentication. LDAP authentication provides the means to administer users in one central location (server), preventing the replication of user information. Both forms of authentication require users to enter their Empower user name and password to log in to Empower. For LDAP authentication, users log in with their LDAP password. When a new Empower user account is created in LDAP mode, the new Empower user name and password defaults to the user’s LDAP user name and password. **Exception:** The Empower 2 user name and full name do not match the LDAP user name when one of these conditions apply:  
  - An existing Empower 2 user name matches the LDAP user name  
  - The LDAP log in name includes characters that are invalid for an Empower 2 user name  
  - The LDAP log in name includes too many or too few characters.  
  In any of these cases, you can change the Empower 2 user name to resolve the issue. When you do so, the Empower 2 user name and full name differ from the LDAP user name, but the LDAP password remains the same as the Empower 2 password. |
Before enabling LDAP authentication, you can specify that a user account remain a local account and not be associated with an LDAP account. To do so, you must select the Always Local Login check box in the New User dialog box. When you select this check box and then enable LDAP Authentication, this user account is governed by the User Account Policies (Accounts and Passwords) tab and not the policies on the LDAP Server. If you do not select this check box, and LDAP Authentication is enabled, the user account must be associated with an LDAP account so that the user can log in to Empower 2 software.

If your organization uses LDAP authentication, you can enable this feature in Configuration Manager > View > System Policies > Authentication tab.

**Requirements:**
- SSL (Secure Socket Layer) certificate must be installed on the LDAP server(s)
- LDAP version 3 is supported

**See also:** Empower 2 online Help “Setting system policies”
There are three new user type privileges in Empower 2 FR 5 software:

- Assign User Types to User - Users with this privilege can assign user types to users regardless of their own user type.

  **Restriction:** Only an Admin user account can assign the Admin user type to other user accounts.

  **Example:** A user assigned the Chemist user type, and the privileges Assign User Types to Users and the Create Users or Alter Users, can create a user or assign to an existing user the Analyst user type, even though the Analyst user type confers more privileges than the Chemist user type.

  Users with the Create Users or Alter Users privilege, but not the Assign User Types to Users privilege, can only create users or assign to an existing user a user type that is equal to or a subset of their own user type.

  **Example:** A user assigned the Chemist type and the Alter Users privilege, but not the Assign User Types to Users privilege, cannot assign to a user the Analyst user type.

- Save Named Table Preferences - Users can select and then save table preferences (such as which columns appear in the Samples table, fonts, and formatting) while editing a sample set method or altering samples in the Sample Set Method Editor, Alter Sample window, or in the Samples or Running tab of the Run Samples window. Empower 2 software provides default table preferences, but users with this privilege can create and then save their own preferences. Table preferences are stored per project and are available to all users.

  **Restriction:** Users without this privilege can temporarily adjust table preferences, but cannot save them.
Empower 2 FR 5 Administrative functions (Continued)

<table>
<thead>
<tr>
<th>FR5 feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Delete Named Table Preferences - Users can delete previously created table preferences for use in the Sample Set Method Editor, Alter Sample window or in the Samples or Running tab of the Run Samples window.</td>
</tr>
<tr>
<td></td>
<td><strong>Restriction</strong>: Users with this privilege cannot delete the default table preferences.</td>
</tr>
<tr>
<td>Web Server</td>
<td>The web server interface is not currently supported.</td>
</tr>
</tbody>
</table>
Database backup and recovery

This chapter describes how to backup and restore the Empower 2 Enterprise database.

Recommendation: Periodically test your sets of backup media to ensure that the backups are working correctly and according to your company's standard protocols for failure recovery.

Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backing up the Empower 2 database using scripts</td>
<td>5-2</td>
</tr>
<tr>
<td>Restoring the Empower 2 database</td>
<td>5-9</td>
</tr>
<tr>
<td>Backing up the Empower 2 database using OEM for Solaris</td>
<td>5-17</td>
</tr>
<tr>
<td>Restoring the Empower 2 database using OEM for Solaris</td>
<td>5-18</td>
</tr>
</tbody>
</table>
Backing up the Empower 2 database using scripts

This section describes the procedures for backing up the Empower 2 database using the backup script files provided by Waters. This section covers the following topics:

- Performing a hot database backup to drive
- Performing a cold database backup to drive

When you install the Empower 2 database, hot and cold backup scripts are written to the program-drive\Empower\Script directory. The scripts can be run manually from a command prompt or as a scheduled task. Both backup scripts move the accumulated archive logs from their default locations to the directories in the backup folder. Backups should be run regularly as part of your disaster recovery strategy and to maintain the archive log destination directories.

The backup scripts are dynamic and automatically query the database each time a backup is run to determine the current locations of all database datafiles, control files, archive logs, and Empower 2 raw data. This allows you to modify the Empower 2 environment, such as additional datafiles and/or multiple raw data file locations without the need to manually revise the backup scripts.

Backup schedule

To protect Empower 2 data, Waters recommends that you perform these tasks:

- A hot backup of the database and the Empower 2 software raw data files at least once a day
- A cold backup of the database and the Empower 2 software raw data files at least once a week

Backup script files

Recommendation: Determine the frequency of backing up based on the relative importance of your data. If you are working with critical data, you might want to back up your files more than once a day, or back up individual projects using the Empower 2 software backup tools.

The cs_hot_gen.bat script backs up database files, control files, redo logs, archive log files, spfile, Oracle password file, and raw data files to a specified
backup drive. It also backs up a control file to trace and the spfile to a pfile. As part of the backup, the archive log files are moved from their default locations to directories within the backup. The database remains up and accessible to users while the backup is in process. If the script is rerun to the same location, the existing backup is deleted and replaced by the new backup.

The following table lists the folders and files that are created by the hot backup script.

**cs_hot_gen.bat database backup script**

<table>
<thead>
<tr>
<th>Folder</th>
<th>Sub-folder and description</th>
</tr>
</thead>
<tbody>
<tr>
<td>archive</td>
<td>Log Archive Dest 1 and Log Archive Dest 2 contain the archive log files.</td>
</tr>
<tr>
<td>backupscript</td>
<td>Contains these files:</td>
</tr>
<tr>
<td></td>
<td>Beginbackup.sql</td>
</tr>
<tr>
<td></td>
<td>EmpowerHBU.sql</td>
</tr>
<tr>
<td></td>
<td>EmpowerHBU.bat</td>
</tr>
<tr>
<td></td>
<td>ArcDir.sql</td>
</tr>
<tr>
<td></td>
<td>ArcDir.bat</td>
</tr>
<tr>
<td></td>
<td>Arc.sql</td>
</tr>
<tr>
<td></td>
<td>Copy_Arc.bat</td>
</tr>
<tr>
<td></td>
<td>Endbackup.sql</td>
</tr>
<tr>
<td></td>
<td>Copy_DB.sql</td>
</tr>
<tr>
<td></td>
<td>Spfilepfile.sql</td>
</tr>
<tr>
<td></td>
<td>StoreDumpDest.sql</td>
</tr>
<tr>
<td></td>
<td>OldDumpDest.sql</td>
</tr>
</tbody>
</table>
The cs_cold_gen.bat script backs up database files, control files, redo logs, archive log files, spfile, Oracle password file, and raw data files to a specified backup drive. It also backs up a control file to trace and the spfile to a pfile. As part of the backup, the archive log files are moved from their default locations to directories within the backup. The database is shut down by the script before the backup begins and restarted once the backup is complete. Users will not be able to access the database while the backup is in process and data acquired during the backup will be buffered locally until the database is restarted. If the script is rerun to the same location, the existing backup is deleted and replaced by the new backup.

Using this script, you can easily back up to a directory that is subsequently backed up as part of the corporate backup strategy. You can use third-party backup applications with this script.

<table>
<thead>
<tr>
<th>Folder</th>
<th>Sub-folder and description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NewDumpDest.sql</td>
<td>Sets new user_dump_dest to backup folder.</td>
</tr>
<tr>
<td>DumpTrace.sql</td>
<td>Copies control file to trace.</td>
</tr>
</tbody>
</table>
| database | Contains redo logs 1 to 4 and mirrored redo logs 1 to 4: Contains these ORA files:  
  • pfile  
  • pwdWAT6 (default SID)  
  • SpfileWAT6  
Contains these DBF files:  
  • INDEX01  
  • SYSAUX01  
  • SYSTEM01  
  • TEMP01  
  • UNDOTBS01  
  • USER01  
The Controlfiles subfolder contains Control files 1 to 3 and the trace files. |
| projects | For each project in the database, there is a sub-directory containing the project’s raw data files. |
The following table lists the files created in the cold database backup script.

### cs_cold_gen.bat database backup script

<table>
<thead>
<tr>
<th>Folder</th>
<th>Sub-folder and description</th>
</tr>
</thead>
<tbody>
<tr>
<td>archive</td>
<td>Log Archive Dest 1 and Log Archive Dest 2 contain the archive log files.</td>
</tr>
<tr>
<td>backupscript</td>
<td>Contains these files:</td>
</tr>
<tr>
<td>shutdown.sql</td>
<td>This script does a shutdown immediate on the database.</td>
</tr>
<tr>
<td>startup.sql</td>
<td>This script restarts the database.</td>
</tr>
<tr>
<td>EmpowerCBU.sql</td>
<td>This script builds the EmpowerCBU.bat file.</td>
</tr>
<tr>
<td>EmpowerCBU.bat</td>
<td>Copies the database files.</td>
</tr>
<tr>
<td>DBVerify.sql</td>
<td>Creates script to build DBVerify.bat.</td>
</tr>
<tr>
<td>DBVerify.bat</td>
<td>Runs DBV on database files.</td>
</tr>
<tr>
<td>ArcDir.sql</td>
<td>Generates a batch file which creates the list directories for each active archive log.</td>
</tr>
<tr>
<td>ArcDir.bat</td>
<td>Creates directories of the backup directory to receive archivelog files.</td>
</tr>
<tr>
<td>Arc.sql</td>
<td>Generates a batch file for the movement of archive logs from each active archive log destination (1-10).</td>
</tr>
<tr>
<td>Arc.bat</td>
<td>Copies the backup logs to the correct backup directory.</td>
</tr>
<tr>
<td>Copy_DF.sql</td>
<td>Generates a batch file for copying the D_Files from all locations specified in the Empower database.</td>
</tr>
<tr>
<td>Spfilepfile.sql</td>
<td>Creates a pfile from spfile.</td>
</tr>
<tr>
<td>StoreDumpDest.sql</td>
<td>Creates OldDumpDest.sql to store old user_dump_dest.</td>
</tr>
<tr>
<td>OldDumpDest.sql</td>
<td>Sets old user_dump_dest to backup folder.</td>
</tr>
<tr>
<td>NewDumpDest.sql</td>
<td>Sets new user_dump_dest to backup folder.</td>
</tr>
</tbody>
</table>
Performing a database backup

The cs_hot_gen.bat file performs a hot backup and the cs_cold_gen.bat file performs a cold backup to a hard disk drive. Whether the backup scripts are manually run from a command prompt or automatically as a scheduled task, the command syntax requires five variables: the location and name of the backup script, a destination location (will be automatically generated if it doesn't already exist), the name of a user with Oracle SYSDBA privileges, the password of the Oracle SYSDBA user, the location of Oracle Home, and the database SID. The command syntax for using these script files is:

<table>
<thead>
<tr>
<th>Folder</th>
<th>Sub-folder and description</th>
</tr>
</thead>
<tbody>
<tr>
<td>database</td>
<td>contains redo Logs 1 to 4 and mirrored redo logs 1 to 4. Contains these ORA files:</td>
</tr>
<tr>
<td></td>
<td>• pfile</td>
</tr>
<tr>
<td></td>
<td>• pwdWAT6</td>
</tr>
<tr>
<td></td>
<td>• SpfileWAT6</td>
</tr>
<tr>
<td></td>
<td>Contains these DBF files:</td>
</tr>
<tr>
<td></td>
<td>• INDEX01</td>
</tr>
<tr>
<td></td>
<td>• SYSAUX01</td>
</tr>
<tr>
<td></td>
<td>• SYSTEM01</td>
</tr>
<tr>
<td></td>
<td>• TEMP01</td>
</tr>
<tr>
<td></td>
<td>• UNDOTBS01</td>
</tr>
<tr>
<td></td>
<td>• USERS01</td>
</tr>
<tr>
<td></td>
<td>The Controlfiles subfolder contains Control files 1 to 3 and the trace file.</td>
</tr>
<tr>
<td>projects</td>
<td>For each project in the database, there is a sub-directory containing the project's raw data files.</td>
</tr>
</tbody>
</table>

5-6 Database backup and recovery
C:\> backupscript backup_location OracleSYSDBA_username Password Oracle_home SID

**Backup Script Variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backupscript</td>
<td>E:\ Empower\ Script\ cs_hot_gen.bat</td>
</tr>
<tr>
<td>Backup_location</td>
<td>G:\ Backup</td>
</tr>
<tr>
<td>Oracle SYSDBA username</td>
<td>SYS</td>
</tr>
<tr>
<td>Exception: When creating multiple database instances on a Windows-based Empower 2 Server, specify a connect string rather than a user name. In the following example, WAT7 is the next service name that exists on the server: Example: connect string: sys@WAT7</td>
<td></td>
</tr>
<tr>
<td>Password (for Oracle SYSDBA user)</td>
<td>Oracle</td>
</tr>
<tr>
<td>Oracle_Home</td>
<td>E:\ Empower\ Oracle\ Oracle10g</td>
</tr>
<tr>
<td>Oracle_SID</td>
<td>WAT6</td>
</tr>
</tbody>
</table>

**To perform a backup to a drive**

1. Click Start > Run, in the Run dialog box, enter CMD, and click OK.

2. In the Command Prompt window, enter the command syntax for the type of backup you want to perform. For example:

   C:\>E:\ Empower\ Script\ cs_hot_gen.bat G:\ Backup sys oracle E:\ Empower\ oracle\ oracle10g wat6

   **Tip:** To perform a cold backup, substitute cs_cold_gen.bat for cs_hot_gen.bat.

   You should now back up the Backup folder using Windows Backup, or a third-party backup application.

**Using Windows Scheduler to schedule database backups**

You can schedule hot and cold backups using the Windows Scheduler.
Rule: When creating multiple database instances on a Windows-based Empower 2 Server, backups must be scheduled on the database server.

To schedule backups

1. Click Programs > Accessories > System Tools > Scheduled Tasks > Add Scheduled Tasks.
2. In the Scheduled Task wizard, browse to the Empower\Script folder.
3. Select either cs_cold_gen.bat or cs_hot_gen.bat, and then click Open.
4. Specify a name for the task, select the frequency for the backup, and then click Next.
5. Enter the time of the backup, and then click Next.
6. Enter the username and password for the Windows User who has sufficient privileges to perform a scheduled task, and then click Next.
7. Click Finish to return to the Scheduled Tasks window.
8. Right-click on the scheduled task, and select Properties.
9. In the Run field, you must add the five backup parameters listed in the table titled "cs_hot_gen.bat database backup script" on page 5-3, and then click OK.
   Example: C:\Empower\Script\cs_hot_gen.bat g:\backup sys oracle E:\empower\oracle\oracle10g wat6
10. In the Set Account Information dialog box, re-enter the Windows Users password, click OK, and then exit the Scheduled Task window.

Each time you run a backup script to the same location, the existing backup directories are deleted. You can schedule multiple backups to different destinations when you want to keep backups for a longer period of time.

Example: You can create seven weekly tasks with different names (such as MondayBackup, TuesdayBackup, etc.) and schedule each task to run on its designated day. In this way, you keep seven days' worth of backups before the oldest is overwritten.

Tip: There is an optional sixth variable that can be used to perform a backup of only the database files, omitting the copy of the raw data files. Use this variable only if you have an alternate backup strategy in place that performs frequent backups of the raw data files. If you need to perform recovery using backups performed at different times (database backup and a separate raw...
data file backup), the database and raw data file information may not be synchronized. To perform a drive backup of the database files only, add the word “Yes” to the end of the backup command syntax in step 9.

Testing backups

Recommendation: Periodically test your sets of backup media to ensure that the backups are working correctly and according to your company’s standard protocols for failure recovery.

Refer to the table titled “cs_hot_gen.bat database backup script” on page 5-3 and the table titled “cs_cold_gen.bat database backup script” on page 5-5 to ensure that the proper scripts were dynamically created at the moment of backup.

Restoring the Empower 2 database

This section addresses these issues:

- Backup set structures
- Recovering from an Empower 2 database drive failure
- Recovering from an Empower 2 raw data drive failure
- Recovering from an Empower 2 program files disk failure
- Recovering from an Empower 2 database drive and raw drive failure

Tip: The recovery procedures described in this section assume a typical server installation according to the instructions detailed in the Empower 2 Installation and Configuration Guide, Rev B. If you have performed a custom installation, you must modify the recovery procedures as needed. For example, if you selected a SID name other than WAT6, supply your SID in place of WAT6.

Database recovery from a hot backup is done through the Database Control Console. Use the procedures in this section to restore the Empower 2 and Oracle data that you backed up using the procedures in “Backing up the Empower 2 database using scripts”.

Note: The most common failure that results in data loss is a hard disk failure. RAID technology can protect against data loss even in the event of a hard disk failure.
The backup set structure

The backup technique (hot or cold drive backup) that you use to back up the Empower 2 database results in a specific backup set structure. When you restore the database from one of these backups, it is important to be familiar with the backup set structure.

The backup set structure

A backup creates a backup folder on the selected drive that has the following structure:

- Archive folder containing the archive (.arc) log files.
- Backupscript folder containing the backup script files.
- Database folder containing the database files, the Oracle password file, the mirrored redo log files, and a sub-folder containing the control files and the trace file.
- Projects folder containing the project raw data files (with each project in its own folder).

Recovering from an Empower 2 database drive failure

This section describes recovering files only in the database-drive\Empower\Database directory. To recover other files or directories, you need to use other means. Loss of other drives or directories can require additional recovery procedures.

Requirement: Ensure that the hardware failure is repaired before you perform this procedure.

Recovering from database drive failure using a hot backup

Requirement: Restoring the Empower 2 database using a hot backup requires the archive log files, a current copy of the redo log files, and the control file from the time of the database failure. (Only one copy of the mirrored redo log files and the control file is required.)

Before you start the recovery process, perform these actions:

- Log in to the operating system as the administrator
- If the database is running, shut it down as described in “Shutting down and starting up the Empower 2 database”.

Recommendation: Waters strongly recommends performing a disk image backup of all other drives before restoring, in case any files are inadvertently deleted or overwritten.

To recreate the database folders and recover the files:

1. To ensure that you have matching database files, remove the entire contents of the database drive\EmpowerDatabase\oradata\WAT6 tree before you restore the backup.
2. Create the EmpowerDatabase\oradata directory under the root of the database drive, and then create a subdirectory of the SID Name.
   
   Example: databasedrive:\EmpowerDatabase\oradata\WAT6.

3. From the hot backup database directory, copy all database datafiles (*.DBF) to the databasedrive: EmpowerDatabase\oradata\SID_Name directory.
4. Delete any redo logs and control files that were copied in.
5. Copy the mirrored control file CONTROL02.CTL and mirrored redo logs (REDO20n.LOG, where n is 1 to 4) from rawdata-drive\EmpowerMirrorDB\oradata\SID_Name directory to database-drive\EmpowerDatabase\oradata\SID_Name directory, and then rename them to CONTROL01.CTL and REDO01.log, REDO02.log, REDO03.log REDO04.log.
6. From the backup archive\LOG_ARCHIVE_DEST_1 directory, copy all archive log files to the programdrive\EmpowerArchive2DB and the rawdata drive\EmpowerArchive1DB directories. Do not delete the existing archive logs.

To restore the database:

1. Start Internet Explorer and then start the Oracle Enterprise Manager Database Control console.
2. Click Startup.
3. In the Startup/Shutdown: Specify Host and Target Database Credentials page, perform these tasks, and then click OK:
• Under Host Credentials, enter the username and password for the Windows DBA user configured in “Configuring the Windows DBA account”.

• Under Database Credentials, enter the username and password for the Oracle SYSDBA, and then select SYSDBA from the Connect As list.

4. At the Startup/Shutdown Confirmation page, click Yes to initiate the database startup.

5. The database starts but fails to open. Click Perform Recovery.

6. At the Perform Recovery: Credentials page, enter this information and click Continue:
   • Under Host Credentials, enter the username and password for the Windows DBA user configured in “Configuring the Windows DBA account”.
   • Under Database Credentials, enter the username and password for the Oracle SYSDBA.

7. At the Perform Recovery: Type page, select “Recover from previously restored data files”, verify that the host credentials are correct, and then click Next.

8. At the Perform Recovery: Point-in-time page, leave the defaults, and then click Next.

9. At the Perform Recovery: Review page, click Submit.

10. At the Operation succeeded message, click OK, and then exit the database Console.

11. To verify that the database is accessible, log in to Empower.

12. Immediately shut down the Oracle database and perform an image backup of the entire database drive or perform a cold drive backup.

Recovering from database drive failure using a cold backup

Requirement: A cold backup restores your database to its state at the point of your last backup. To ensure that the raw data files are synchronized with the database, restore the raw data files that were backed up at the time of the cold backup.
Before you start the recovery process, perform these actions:

- Log in to the operating system as the administrator
- If the database is running, shut it down as described in “Shutting down and starting up the Empower 2 database”.

**To recover from database drive failure using a cold backup:**

1. To ensure that you have matching database files, remove the entire contents of the database drive\EmpowerDatabase\oradata\WAT6 tree before you restore the backup.

2. Create the EmpowerDatabase\oradata directory under the root of the database drive, and then create a subdirectory of the SID Name.
   
   **Example:** databasedrive:\EmpowerDatabase\oradata\WAT6.

3. From the cold backup database directory, copy all database datafiles (*.DBF), redo0n log files (where n is 1 to 4), and from the Controlfile folder copy Control01.CTL, to the databasedrive\EmpowerDatabase\oradata\SID_Name directory.

4. Copy the contents of the rawdata drive\EmpowerMirrorDB\oradata\WAT6 to a neutral location.
   
   **Tip:** These files may be used if additional recovery is necessary. The additional recovery is not covered in this procedure.

5. Delete the contents of rawdata drive\EmpowerMirrorDB\oradata\WAT6.

6. From the cold backup database\controlfiles directory, copy Control02 and Control03 to the rawdata drive\EmpowerMirrorDB\oradata\WAT6.

7. From the cold backup database directory, copy REDO0n log files (where n is 1 to 4) to the rawdata drive\EmpowerMirrorDB\oradata\WAT6.

8. Restart the computer.
Recovering from an Empower 2 software raw data drive failure

The Empower 2 software raw data disk contains the raw chromatographic files, EmpowerMirrorDB and the EmpowerArchive1DB directories. In this situation, you do not lose Empower 2 database information, because the Empower 2 database disk remains intact.

**Exception:** Because chromatographic files produced between the last backup and the time of a disk failure are not recoverable, you cannot review or otherwise use chromatograms acquired or their results during that time period; however, all methods created or edited, sample loading information, and results generated since the last backup are available.

Recovering from raw data drive failure

If you have a current image backup of the Empower 2 raw data disk, restore the disk image before you continue with this section. This restores any non-Empower 2-related data you might have placed on the disk.

Before you start the recovery process, perform these actions:

- Log in to the operating system as the administrator.
- If the database is running, shut it down as described in “Shutting down and starting up the Empower 2 database”.

**Tip:** In this procedure, substitute your SID for WAT6 if your SID is different.

To recover from a raw data drive failure:

1. Create the Projects directory on the raw data drive:
   rawdatadrive\Empower\Projects.
2. From the backup projects directory, copy all projects’ folders to the rawdatadrive\Empower\Projects directory.
3. Share the Projects directory with the share name Waters_Projects$ and set the appropriate level of security as described in the Empower 2 Installation and Configuration Guide, Rev B.
4. From the databasedrive\EmpowerDatabase\oradata\SID_Name (WAT6) directory, copy Control01 to the rawdata drive\EmpowerMirrorDB\oradata\WAT6.
5. In the rawdata drive\EmpowerMirrorDB\oradata\SID_Name (WAT6) directory, rename Control01.CTL to Control02.CTL.
6. From the databasedrive\EmpowerDatabase\oradata\SID_Name (WAT6) directory, copy Control01 to the rawdata drive:EmpowerMirrorDB\oradata\WAT6.

7. In the rawdata drive:EmpowerMirrorDB\oradata\WAT6 directory, rename Control01.CTL to Control03.CTL.

8. From the databasedrive\EmpowerDatabase\oradata\SID_Name (WAT6) directory, copy REDO0n log files (where n is 1 to 4) to the rawdata drive:EmpowerMirrorDB\oradata\WAT6.

9. In the rawdata drive:EmpowerMirrorDB\oradata\WAT6 directory, rename REDO0n.LOG log files to REDO20n.LOG (where n is 1 to 4).

10. Create the archive log directory rawdatadrive\EmpowerArchive1DB.

11. From the program-drive\EmpowerArchive2DB directory, copy all contents of the directory to rawdatadrive\EmpowerArchive1DB.

12. Restart the server.

Recovering from an Empower program files disk failure

The Empower 2 program files disk contains the Empower program file, the Empower\Script directory, and the Oracle directory oracle_home, including the Oracle password file (pwdWATn.ora) and the EmpowerArchive2DB directory containing one set of archive log files. Recovering this disk involves reinstalling Empower and Oracle.

In the case of partial disk failure (such as bad data sectors), where all archive (*.arc) files can be saved from the disk, back up the database drive immediately. The archive files can then be copied to a tape or network drive before the disk is repaired. This allows restoration of the database to the state at the time of failure.

**Recommendation:** Waters strongly recommends performing a disk image backup of all other drives, in case any files are inadvertently deleted or overwritten. Ensure that the target directories have sufficient disk space to copy the files.

Recovering from a program drive failure

The best option is to restore a disk image backup of the entire drive, if available. If a disk image backup of the program files disk is not available, or
your backup does not include the latest changes, then Empower 2 and Oracle must be reinstalled as follows:

**To recover from an Empower program drive failure:**

1. Manually back up the contents of the 
   databasedrive\EmpowerDatabase\oradata\SID_Name directory to a 
   safe location, such as a network drive, and then delete the 
   databasedrive\EmpowerDatabase directory. 
   **Tip:** If you have a custom installation and Oracle was installed on a 
   separate drive from the Empower program files, the database may still 
   be up and running. Make sure the database is shut down before copying 
   the databasedrive\EmpowerDatabase\oradata\SID_NAME files. 

2. Manually back up the contents of the rawdatadrive\Empower\Projects 
   directory to a safe location, such as a network drive, and then delete the 
   rawdatadrive\Empower\Projects directory. 

3. Manually back up the rawdatadrive\EmpowerArchive1DB and 
   rawdatadrive\EmpowerMirrorDB directories to a safe location, and 
   then delete the directories. 

4. Delete the Operating System drive\Program Files\Oracle directory. 

5. Reinstall Empower from the Empower 2 DVD as described in Chapter 4 
   of the Empower 2 Installation and Configuration Guide to the same 
   location that it was originally installed and use same SID. 

6. Access Services and set the Startup Type for the following services to 
   Disabled: 
   - OracleServiceSID_Name 
   - OracleEmpower10gTNSListener 

7. Restart the server. 

8. Replace the contents of the 
   databasedrive\EmpowerDatabase\oradata\SID_NAME with the files 
   backed up in step 1. 

9. Replace the contents of the programdrive\EmpowerArchive2DB 
   directory with the contents of EmpowerArchive1DB files you backed up 
   in step 3. 

10. Replace the contents of the rawdatadrive\Empower directory including 
    the Projects sub-directory with the files that you backed up in step 2

5-16 Database backup and recovery
11. Replace the contents of rawdatadrive\EmpowerArchive1DB and 
    rawdatadrive\EmpowerMirrorDB directories with files you backed up 
    in step 3.

12. Share the rawdatadrive\Empower\Projects directory with the share 
    name Waters_Projects$, and then set the appropriate level of security as 
    section specified in the Empower 2 Installation and Configuration 
    Guide.

13. Access Services and set the Startup Type for the following services to 
    Automatic:
    - OracleServiceSID_Name
    - OracleEmpower10gTNSListener

14. Restart the server.

Recovering from a database and raw data drive failure

If both the Empower 2 database drive and the Empower 2 raw data drive fail, 
the mirrored control files become unrecoverable. This situation requires that 
you restore using a cold backup.

Tip: If you have performed only hot backups, recovery is possible. This 
requires, however, a more involved recovery procedure that is beyond the 
scope of this guide.

To recover from a database and raw data drive failure

1. Follow the steps in “Recovering from database drive failure using a cold 
   backup”.

2. Follow the steps in “Recovering from an Empower 2 software raw data 
   drive failure”.

Backing up the Empower 2 database using OEM for Solaris

This section describes how to back up the Empower 2 Enterprise database 
using the Oracle Enterprise Manager (OEM) for Solaris only. The procedures 
explain backing up the entire database.

Before you back up the database, make sure you have recorded the following 
information:
Database unique name
Database ID
Location of the flash recovery area.

For details on locating this information, see “Recording database information”.

To back up the Empower 2 database:
1. Start Internet Explorer and log in to Oracle Enterprise Manager (OEM) with the SYS account as SYSDBA.
2. In the Database Instance, click the Maintenance tab, and then click Schedule Backup.
3. On the Schedule Backup page, under Customized Backup, select Whole Database.
4. Under Host Credentials, enter the username and password for a local administrator.
5. Click the Schedule Customized Backup button.
6. In the Schedule Customized Backup: Review page, review the settings, and then click Submit Job.

Result: The database is backed up. When the backup is complete, the Execution page displays, indicating the status of the database backup in the Summary area.

Testing your backups

Recommendation: Periodically test your sets of backup media to ensure that the backups are working correctly and according to your company’s standard protocols for failure recovery.

Restoring the Empower 2 database using OEM for Solaris

This section describes how to restore the Empower 2 Enterprise database using Oracle Enterprise Manager (OEM) for Solaris.

Requirement: The recovery procedures described in this section assume a typical server installation such as the one detailed in the Empower 2 Installation and Configuration Guide, Rev B.
Before restoring the Empower 2 database, perform these actions:

- Log in as Oracle.
- If the database is running, shut it down.
  
  **Recommendation:** Waters strongly recommends performing a disk image backup of all other drives before restoring, in case any files are inadvertently deleted or overwritten.

You can use the following procedure to recover a lost database up to the point of failure if the following criteria are met:

- The database is in archivelog mode.
- The control file is mirrored to separate physical disks and at least 1 current control file is still accessible.
- The redo logs are mirrored to a separate physical disk and at least 1 current set of redo logs is accessible.
- Regularly scheduled Recovery Manager (RMAN) backups are performed and accessible.

**To verify that the database is shut down:**

1. Start Internet Explorer and access Oracle Enterprise Manager.
2. Click Startup.
3. On the Startup/Shutdown: Specify Host and Target Database Credentials page, enter the appropriate user credentials, and then click OK.
4. On the Startup/Shutdown: Confirmation page, verify that the Current Status is shutdown. If it is anything other than shutdown, shutdown the database.

**To recover from a database drive failure:**

1. Recreate the directory structure of the database drive (recreate the path to the database files).
2. Go to the location of the SPFILE.
   
   **Tip:** This file is typically in the /dbs directory in your ORACLE_HOME location. For example: ORACLE_HOME/empower/dbs/spfileSID.ora.
   
   Rename the SPFILE with the extension .OLD.
3. In the OEM web console, click Perform Recovery.
4. On the Perform Recovery: Credentials page, enter the appropriate Host and Database Credentials, and then click Continue.
5. At the OEM – Perform Recovery: Restore SPFILE page, perform these actions, and then click Continue:
   - Enter the required information:
     - Database name (db_unique_name)
     - Database ID (DBID)
     - Location of the flash recovery area
   - Select “Directly restore from a specified backup.”
6. Wait until the Perform Recovery: Restore SPFILE page reappears, enter the name of the backup file in the Backup Selection area, and then click Restore.
   **Tip:** The backup set consists of multiple .bkp files. You must provide the path to the specific .bkp file that contains the SPFILE.
   For example: u01/app/oracle/flash_recovery_area/WATG/backupset/2005_11_13/01_mf_ncsnf_backup_UNIX1.WATG_1_1qgodh5v.bkp.
7. On the OEM – Perform Recovery: Restore Control File page, enter the required information, and then click Restore.
8. On the Perform Recovery page, select Recover to the current time or a previous point-in-time, and then click Perform Whole Database Recovery.
9. On the Perform Recovery: Point-in-time page, leave the defaults as they are (to attempt recovery up to the time of the failure), and then click Next.
10. On the Perform Recovery: Rename page, leave the default to restore the datafiles to their original locations, and then click Next.
11. On the Perform Recovery: Review page, review the recovery information, and then click Submit.
12. On the Operation Succeeded page, review the RMAN log of actions performed to verify that media recovery was complete, and then click OK.
If the database does not start automatically, the Startup/Shutdown operation page appears. Select Open the database with RESETLOGS option, and then click Continue. Log back in to the database with sysdba credentials and verify that the database is restored to full functionality.
Troubleshooting

This chapter provides guidelines for isolating and correcting system-level problems that can occur with the Empower 2 Enterprise or Workgroup system. It describes possible symptoms and corrective actions for both hardware and software problems.

For complete information on reporting shipping damages and submitting claims, see Waters Safety Notices, Licenses, Warranties, and Support.

Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional help</td>
<td>6-2</td>
</tr>
<tr>
<td>Isolating problems</td>
<td>6-2</td>
</tr>
<tr>
<td>Reporting problems</td>
<td>6-3</td>
</tr>
<tr>
<td>Buffering and data recovery problems</td>
<td>6-4</td>
</tr>
<tr>
<td>Disconnecting dead connections</td>
<td>6-6</td>
</tr>
<tr>
<td>Audit trail settings for restored projects</td>
<td>6-6</td>
</tr>
<tr>
<td>Software problems</td>
<td>6-8</td>
</tr>
<tr>
<td>Hardware problems</td>
<td>6-11</td>
</tr>
<tr>
<td>Troubleshooting procedures</td>
<td>6-16</td>
</tr>
</tbody>
</table>
Additional help

For additional Empower 2 system troubleshooting help, consult the following documentation:

- Empower 2 online Help
- Windows Help
- Hardware documentation shipped with your system hardware
- Operator’s guides for detectors, pumps, autosamplers, and other components of the chromatography system
- Empower 2 FR 5 Software Release Notes
- www.Waters.com

Waters Technical Service

If the corrective actions suggested here fail to correct a problem, consult “Reporting problems” on page 6-3 and then contact Waters for assistance. Customers in the USA and Canada should report the problems to Waters Technical Service (800 252-4752). Others should phone their local Waters subsidiary or Waters corporate headquarters in Milford, Massachusetts (USA), or they may visit http://www.waters.com.

Isolating problems

Isolating the problem is the first step in troubleshooting. Because the necessary procedure depends on system type, this chapter provides general instructions for isolating a problem.

Recommendations

Keep in mind the following recommendations when attempting to isolate a problem:

- Develop a systematic troubleshooting strategy.
- Check simple things first, such as cable connections and privileges.
- Try to reproduce a symptom and note all steps leading up to the problem.
- Make only one change at a time to identify the cause of a problem.
Software problems in the Empower 2 software application can generate an Empower error message. If no message appears, or if you cannot log in, the problem can be a setup problem.

For an instrument control problem, remove the device in question from the Ethernet cable, and if possible control the device from its front panel. If the device does not respond as expected when programmed from its front panel, the problem is within the instrument, not the Empower 2 system.

Check the Empower 2 Message Center for errors.

Check the operating system's Event Viewer for errors.

Recording problems

Record all system problems and troubleshooting activities in the System Problem Log. See “System problem log” on page B-13 for sample log forms.

Reporting problems

Before you contact Waters technical assistance, make sure you have adequately investigated the problem. If the corrective actions listed in this chapter do not solve the problem, collect all your troubleshooting information, as well as the System Problem log, relevant technical manuals, and contact Waters.

When you contact Waters, be ready to offer the following information:

- Software support plan number
- A description of the symptoms
- An accurate assessment of the problem's severity; for example, system down, server, down, PC down, PC client not connecting to server, printer printing unusual characters, or occasional malfunction
- When the problem started, whether it is reproducible, intermittent, or constant, and whether it is data-related or account-related
- The specific sequence of events leading to the problem
- Whether the system has been recently modified, new hardware or software installed, or maintenance has been performed
- Actions you took to correct the problem
- Version information for:
- Empower 2 software (obtain the build number from any Help > About dialog box)
- Windows Vista Enterprise Service Pack 1, Windows XP Service Pack 2 Professional, Windows Vista Business operating system software (use the System applet in Control Panel for the software version)
- Waters HPLC devices and instruments (see the appropriate operator’s guides for information on obtaining firmware versions)
  - Basic configurations and serial numbers of the hardware components involved
  - Hard-copy examples of printouts
  - User manuals for the components

Be prepared to perform these tasks:
- Swap cables, if you have not already tested cables
- E-mail or FAX hard-copy documentation of the problem

Recommendation: Be sure to call from a location that is close to the system in question. Your Waters Technical Support representative can help you more effectively if you have access to the system while you are on the telephone.

Buffering and data recovery problems

Empower 2 software provides data buffering and recovery to safeguard your acquired data in the event of a server or network failure. If the LAC/E\textsuperscript{32} acquisition server or the acquisition client loses its connection to the Empower 2 database or to the file server that is storing the project’s raw data, Empower 2 stores the acquired data temporarily on the LAC/E\textsuperscript{32} acquisition server or acquisition client’s hard drive, on the drive where the Empower 2 program files are installed. Once the network connection has been restored, the LAC/E\textsuperscript{32} acquisition server or acquisition client resumes sending the data to the appropriate server or servers.

Tip: Database information (sample identifiers, method information, results, and so on) is stored in the Empower 2 database on the Empower 2 server. By default, chromatographic raw data is stored in the rawdata-drive:\ Empower\ Projects directory on the Empower 2 server. You can change the location of raw data using the Manage Raw Data Files capability (see “Managing raw data files” on page 4-10) to another computer...
as long as the Waters Service is present. Hence, data are buffered when the Empower 2 database or the computer storing the project raw data (\servername\Waters_Projects$, by default) is not available on the network for any reason.

**Reconnecting while buffering**

When buffering is taking place, the chromatographic data currently being acquired is stored in the \Empower\InstrumentServer directory on the acquisition server. When this occurs, the acquisition server attempts to reconnect to the appropriate server(s) after each injection. If the acquisition server reconnects, then the buffered injection(s) is copied over the network to the appropriate location(s). The software then deletes the raw data files on the acquisition server’s hard drive, buffering stops and normal acquisition continues.

The appropriate network connection(s) must be intact before you can acquire a sample set. Immediately after acquiring of a sample set begins, the Empower 2 software downloads all methods required to complete data acquisition to the acquisition server. This downloading sequence must end before acquisition and subsequent buffering can occur.

If data are still being buffered after acquisition of a sample set or a single injection is complete, the acquisition server checks the appropriate network connection every 10 minutes (approximately) until the connection is restored, at which time the data is copied to the appropriate location and then deleted from the acquisition server.

**Note:** The Empower 2 software also buffers data from all queued sample sets, if necessary.

**Continuing acquisition while buffering**

When buffering is taking place, acquisition continues for the remainder of the queued sample sets. The following conditions exist while buffering is occurring:

- Acquisition continues in Run Only, Continue on Fault mode.
- The real-time plot may not appear in Run Samples.
- The buffered data cannot be seen in the Review window.
- An “x” appears on the disk icon in the Run Samples window. (This icon is displayed in the status bar in the lower-right corner next to the clock.)
When the network connection is restored, and normal acquisition resumes, these conditions no longer apply.

**Disconnecting dead connections**

If you receive the “server busy” message when you try to move project data or manually archive projects, the LAC/E acquisition server may be running with no active connections. This could happen if the device was turned off unexpectedly, as with a power failure. If you look at the Projects tab in System Monitor, there may be hung processes that need to be disconnected. You can automatically check for dead connections by editing the sqlnet.ora file.

**To automatically disconnect dead connections**

1. Log in to the database server.
2. In Notepad, open the sqlnet.ora file.
3. Enter the following commands:
   ```
   sqlnet.authentication_services = (NTS)
   sqlnet.expire_time=X
   ```
   Where X equals the number of minutes after which you want the database to check for dead connections, for example every 10 minutes.
   
   **Tip:** If you set this parameter too small, such as 2 minutes, it may slow database performance.
4. Reboot the database server.
5. Check System Monitor to ensure all processes are clear.

**Audit trail settings for restored projects**

If a project is restored from Millennium software, you might not be able to modify its audit trail settings because additional audit trail parameters have been added to the software since the version in which the audit trail feature was first introduced. If a particular setting was available in the software version in which the project was originally backed up, then the setting of the restored project comes from the original project and cannot be changed during the restoration. If a setting was not available in the software version in which the project was backed up, then the setting can be changed as the current...
system policy allows, just as when you are creating new projects. The following table outlines the origin of each full audit trail setting based on the software version of the original backup.

For more information on system policies, see the Empower 2 online Help.

**Origin of full audit trail settings**

<table>
<thead>
<tr>
<th>Source of project being restored</th>
<th>Full audit trail setting (Enabled or Disabled)</th>
<th>Method changes setting</th>
<th>Result changes setting</th>
<th>Sample changes setting</th>
<th>Deletion setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Empower/Empower 2 Software</td>
<td>From backed up project</td>
<td>From backed up project</td>
<td>From backed up project</td>
<td>From backed up project</td>
<td>From backed up project</td>
</tr>
<tr>
<td>Millennium 32 version 4.0</td>
<td>From backed up project</td>
<td>From backed up project</td>
<td>From backed up project</td>
<td>From backed up project</td>
<td>From backed up project</td>
</tr>
<tr>
<td>Millennium 32 version 3.2</td>
<td>From backed up project</td>
<td>From backed up project</td>
<td>From backed up project</td>
<td>From backed up project</td>
<td>From current system policy</td>
</tr>
<tr>
<td>Millennium 32 version 3.0x</td>
<td>From backed up project</td>
<td>From current system policy</td>
<td>From current system policy</td>
<td>From current system policy</td>
<td></td>
</tr>
<tr>
<td>Millennium pre-version 3.0</td>
<td>From current system policy</td>
<td>From current system policy</td>
<td>From current system policy</td>
<td>From current system policy</td>
<td></td>
</tr>
</tbody>
</table>
# Software problems

The following table includes symptoms, possible causes, and suggested corrective actions for general software problems.

## Troubleshooting software problems

<table>
<thead>
<tr>
<th>Symptoms</th>
<th>Possible cause</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>System performance degraded.</td>
<td>Not enough free disk space.</td>
<td>In Explorer, view the properties of the drives used to check free disk space. Archive or delete files if disk space is low (see &quot;Managing the server disk space&quot; on page 2-4).</td>
</tr>
<tr>
<td></td>
<td>Not enough contiguous free disk space (disk fragmentation).</td>
<td>Defragment the drive: Perform a backup and restore all hard disks or you can use the OS disk defragmenter by clicking Start &gt; All Programs &gt; Accessories &gt; System Tools &gt; Disk Defragmenter.</td>
</tr>
<tr>
<td>Errors when checking disk status.</td>
<td>Problem with hard disk.</td>
<td>See the Windows Vista, Windows XP, or the Windows 2000 or 2003 documentation.</td>
</tr>
<tr>
<td>Client cannot connect to the database.</td>
<td>Server is down.</td>
<td>Restart the server.</td>
</tr>
<tr>
<td></td>
<td>Listener is not running.</td>
<td>The listener is a service. Start the listener using the Services applet in Control Panel.</td>
</tr>
<tr>
<td></td>
<td>Client configuration problem.</td>
<td>Verify that the entries in the client’s tnsnames.ora file are correct or that the TNS_ADMIN variable is pointing to the correct share.</td>
</tr>
</tbody>
</table>
### Troubleshooting software problems (Continued)

<table>
<thead>
<tr>
<th>Symptoms</th>
<th>Possible cause</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network problem.</td>
<td></td>
<td>Ensure that the network cabling is properly connected. Use the Windows XP, Vista, or Windows 2000 TCP/IP utility on the client to ping the server. When routing, ensure that the default gateway is set properly.</td>
</tr>
<tr>
<td>Client can not connect to Run Samples on the LAC/E acquisition server.</td>
<td>User does not have appropriate privileges.</td>
<td>From the client, ensure that user is logged in to the correct domain relationship.</td>
</tr>
<tr>
<td>When attempting to process data using Run and Report or background processing, no results are created.</td>
<td>The Empower path cannot be located.</td>
<td>Ensure that the Empower path is listed before other paths in the operating system's path environment variable.</td>
</tr>
<tr>
<td></td>
<td>The TNS_ADMIN variable references a Win2003 database server that has not had its security settings properly configured.</td>
<td>Refer to Section 4.2.4 in the Empower 2 Installation and Configuration Guide.</td>
</tr>
<tr>
<td>An error stating “No COM connection” occurs when attempting to connect to an acquisition server.</td>
<td>Either the Waters Service is not running or the acquisition server is not in a domain relationship.</td>
<td>Start the Waters Service (if the Waters Service is not on the list of services in the operating system, call Waters Technical Support) or enable two one-way trusts between the domains.</td>
</tr>
</tbody>
</table>
Troubleshooting software problems (Continued)

<table>
<thead>
<tr>
<th>Symptoms</th>
<th>Possible cause</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client in another domain cannot access Empower resources.</td>
<td>Domain trusts are not set up.</td>
<td>Ensure there is a two-way trust between domains, or create an account in the Empower domain specifically for that user.</td>
</tr>
<tr>
<td>Run not starting, database fetch error, or connect error.</td>
<td>Incorrect database alias for LAC/E(^{32}) acquisition server.</td>
<td>Check the database alias on the LAC/E(^{32}) or acquisition client for the database you are trying to connect to.</td>
</tr>
<tr>
<td>LAC/E(^{32}) began acquisition in buffering mode.</td>
<td>Mismatch of database service names between clients and LAC/E(^{32}) acquisition server.</td>
<td>Standardize tnsnames.ora file.</td>
</tr>
<tr>
<td>Client cannot see chromatograms or create and/or delete projects.</td>
<td>User is not logged in to the domain or permissions are not correct in the raw data share.</td>
<td>See the Empower 2 System Installation and Configuration Guide.</td>
</tr>
<tr>
<td>Enterprise Manager console displays a warning message informing you that there are a large number of cursors open.</td>
<td>Known Oracle bug.</td>
<td>Ignore the warning because it is a known defect for the Enterprise Manager Console. Open Cursors for Oracle 10.1.0.4. The number displayed is a cumulative number of open cursors and there is nothing wrong with the database.</td>
</tr>
</tbody>
</table>

**ACQUITY UPLC problems**

If you experience problems with your ACQUITY UPLC system, you can use Connections INSIGHT iHelp service, which offers on-demand help and support. You must install Connections INSIGHT software on the Empower 2 workstation that is connected to the ACQUITY UPLC system and the computer where you control the ACQUITY UPLC system. The iHelp Request service automatically and securely captures a snapshot of your system’s...
profile with your question and sends the information directly to the Waters Global Technical support team. The support team contacts you immediately to help resolve your system issue.

To submit an iHelp request

1. Select Troubleshoot > Submit iHelp Request.
2. Type your name, telephone number, email address, and a description of the problem.
3. Click Submit. Allow approximately 5 minutes to save the service profile.

Result: A ZIP file containing your Connections INSIGHT profile is forwarded to Waters for review. Saving a service profile or plot file from an ACQUITY UPLC system might require at least 150 MB of file space.

Hardware problems

The troubleshooting tables in this section include symptoms, possible causes, and suggested corrective actions for problems with the following hardware components:

- Acquisition (see the table titled “Troubleshooting the LAC/E acquisition client” on page 6-12)
- Printer (see the table titled “Troubleshooting the printer” on page 6-13)
- Citrix (see the table titled “Troubleshooting Citrix problems” on page 6-15)

If the troubleshooting procedures in this section do not correct a problem with your system, see the manual shipped with the hardware and perform the recommended test and diagnostic procedures. If you discover a problem that requires repair of a component, check your maintenance agreement for the appropriate support organization to contact.
See the Empower 2 online Help for additional troubleshooting information, maintenance procedures, and status messages.

**Troubleshooting the LAC/E\(^{32}\) acquisition client**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible cause</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAC/E(^{32}) acquisition client power LEDs do not glow.</td>
<td>LAC/E(^{32}) acquisition client not plugged in to power outlet.</td>
<td>Connect the LAC/E(^{32}) acquisition client to the power outlet.</td>
</tr>
<tr>
<td></td>
<td>LAC/E(^{32}) acquisition client power not on.</td>
<td>Power on the LAC/E(^{32}) acquisition client.</td>
</tr>
<tr>
<td></td>
<td>No power at outlet.</td>
<td>Check power at the outlet.</td>
</tr>
<tr>
<td></td>
<td>Hardware failure.</td>
<td>Call Waters Technical Service.</td>
</tr>
<tr>
<td>Failure to connect LAC/E(^{32}) Acquisition Server over the network or through Empower.</td>
<td>Incorrect LAC/E(^{32}) acquisition server configuration.</td>
<td>Check that the LAC/E(^{32}) acquisition server is in the correct network domain. Check configuration of all network parameters.</td>
</tr>
<tr>
<td></td>
<td>Network card not functioning.</td>
<td>Call Waters Technical Service.</td>
</tr>
<tr>
<td></td>
<td>busLAC/E hardware error.</td>
<td>Call Waters Technical Service.</td>
</tr>
<tr>
<td>Data files not available for review because data files were not copied to database server.</td>
<td>Waters Service not running on LAC/E(^{32}) acquisition server or acquisition client.</td>
<td>Set Waters Service Startup to Automatic, then reboot the LAC/E(^{32}) acquisition server or acquisition client.</td>
</tr>
<tr>
<td></td>
<td>Waters Service not running on database server.</td>
<td>Set Waters Service Startup to Automatic, then start the service; wait up to 10 minutes for data file upload.</td>
</tr>
<tr>
<td></td>
<td>General networking failure.</td>
<td>Call Waters Technical Service.</td>
</tr>
</tbody>
</table>
Troubleshooting the LAC/E³² acquisition client (Continued)

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible cause</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot see print resources from Run Samples.</td>
<td>Print queues not registered.</td>
<td>Register print queues on the LAC/E³² acquisition server or acquisition client using Remote Administration software by selecting Start &gt; Programs &gt; Empower &gt; Register Empower Node Printers. You must be logged in to the operating system as an Administrator.</td>
</tr>
<tr>
<td>Could not recover all sample set data when performing a run on LAC/E³² acquisition server.</td>
<td>Network cable was removed causing data buffering.</td>
<td>The TNS_ADMIN variable inhibits recovery after removal of a network cable. Use a local tnsanmes file, and then upload sample set data.</td>
</tr>
</tbody>
</table>

Troubleshooting the printer

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible cause</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>No response when you power on printer.</td>
<td>Power cord not connected.</td>
<td>Securely connect the power cord to the printer and wall outlet.</td>
</tr>
<tr>
<td>No power at wall outlet.</td>
<td></td>
<td>Check the wall outlet. Plug the terminal or monitor power cord into a working outlet.</td>
</tr>
<tr>
<td>Hardware failure.</td>
<td></td>
<td>Call the printer manufacturer.</td>
</tr>
</tbody>
</table>
## Troubleshooting the Printer (Continued)

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible cause</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer does not print</td>
<td>Printer not powered on</td>
<td>Power on the printer.</td>
</tr>
<tr>
<td></td>
<td>Printer not online</td>
<td>Check the Ready LED on the printer. If it is not lit, consult the user guide that accompanies the printer.</td>
</tr>
<tr>
<td></td>
<td>Data or method problem</td>
<td>Preview the file to screen. If the file previews to the screen, troubleshoot the printer. If the file does not preview to the screen, the problem is data-related or method-related.</td>
</tr>
<tr>
<td></td>
<td>Paper jammed.</td>
<td>Reload the paper. Make sure paper is threaded properly and/or the correct paper is loaded.</td>
</tr>
<tr>
<td></td>
<td>Print queues not running properly</td>
<td>Check printer settings and properties. Use the Index tab of the Windows Vista Help, Windows XP Help, or the Windows 2000 or 2003 Help to search for printer topics. If a queue is stopped, stalled, or paused, restart the printer.</td>
</tr>
<tr>
<td></td>
<td>Printer not connected to system.</td>
<td>Check the cable connections to the computer or network.</td>
</tr>
<tr>
<td></td>
<td>Wrong printer specified</td>
<td>Specify the correct printer.</td>
</tr>
<tr>
<td></td>
<td>Printer error.</td>
<td>Check the printer display for an error. See the owner's guide to troubleshoot the error.</td>
</tr>
<tr>
<td></td>
<td>No batch or run and report printing</td>
<td>Register the Empower Node printers as a local or domain Admin.</td>
</tr>
</tbody>
</table>
**Troubleshooting the printer** (Continued)

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible cause</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer does not print (continued)</td>
<td>No batch or run and report printing.</td>
<td>Check printer privileges on the printer server. Set permissions to Everyone.</td>
</tr>
</tbody>
</table>

**Troubleshooting Citrix problems**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible cause</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>When using Citrix Web interface to access Empower 2 software as a browser-enabled application, the Empower Login window launches full screen and may crash if a user clicks the Advance button.</td>
<td>The appearance of the Citrix Web interface is set to maximize windows when they open.</td>
<td>In the Citrix Management console, access the Application Appearance table and clear the Maximize application on startup check box.</td>
</tr>
<tr>
<td>When using Citrix Web interface to access Empower 2 software as a browser-enabled application, a user cannot select the System Default Interface.</td>
<td></td>
<td>In the Citrix Management console, access the Application Appearance table and clear the Maximize application on the startup check box.</td>
</tr>
</tbody>
</table>
**Troubleshooting procedures**

**Evaluating Windows error messages**

System messages from the Windows operating system and its various utilities share a similar format. Take note of the information in the message.

For additional information, click the ? button, the Help button, or the F1 key. Click OK after you read the message.

---

**Troubleshooting Citrix problems (Continued)**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible cause</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>When using Citrix Web interface to access Empower 2 software, local drives and directories are not accessible as options when you perform tasks that enumerate the local drives, such as backing up and restoring a project.</td>
<td>This behavior is related to the response given to the ICA Security dialog box that appears the first time a user performs a task that requires enumeration of the local drives; for example, when projects are backed up or restored or when methods or reports are exported.</td>
<td>If at any time “No Access” was selected from the ICA Security dialog box, no Citrix web interface users will be able to access the client local drives on that workstation. If the user makes an incorrect selection for the ICA Security settings, browse to the %Systemroot%\webica.ini file. The next time a user performs an action requiring enumeration of the local drives, the ICA Security dialog box will appear and ask the user to select the appropriate level of access. At this time, select “Full Access” and “Never ask again for any application”. A new webica.ini file with these parameters will be created.</td>
</tr>
</tbody>
</table>
Tip: Windows Vista operating system provides more information within the error message dialog box.

For more information about Windows operating system and utility error messages, see the Windows Vista Help, Windows XP Help, or Windows 2000 or 2003 Help or the Microsoft Web site.

Evaluating Empower 2 software error messages

Empower 2 software application status and error messages appear in the Message Center on the client. For details on the Message Center error messages, see the Empower 2 online Help.

If you need to call Technical Support about an error message, note the particular error and document the steps required to recreate the error before contacting Waters.

Evaluating Oracle error messages

For information about Oracle system and utility error messages, see the Empower 2 FR 5 Oracle Documentation DVD.

To review Oracle error messages:

1. Launch autorun.
2. Click Install Empower Software.
3. Click Optional Components.
4. In the Optional Components dialog box, click Browse Oracle Documentation. The Oracle Database Documentation library appears.
5. To search for a specific error, select the Search tab, and enter the error message, and then click Search.

Caution: If you create or modify database objects in response to Oracle error messages you can negatively affect Empower 2 software performance, and revalidating Empower 2 software can become necessary. Contact your Waters Data Specialist before implementing any database changes.

If you need to call Technical Support about an error message, note the particular error and document the steps required to recreate the error before contacting Waters.
Waters instruments display hazard symbols designed to alert you to the hidden dangers of operating and maintaining the instruments. Their corresponding user guides also include the hazard symbols, with accompanying text statements describing the hazards and telling you how to avoid them. This appendix presents all the safety symbols and statements that apply to the entire line of Waters products.

### Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning symbols</td>
<td>A-2</td>
</tr>
<tr>
<td>Caution symbol</td>
<td>A-5</td>
</tr>
<tr>
<td>Warnings that apply to all Waters instruments</td>
<td>A-5</td>
</tr>
<tr>
<td>Electrical and handling symbols</td>
<td>A-11</td>
</tr>
</tbody>
</table>
Warning symbols

Warning symbols alert you to the risk of death, injury, or seriously adverse physiological reactions associated with an instrument’s use or misuse. Heed all warnings when you install, repair, and operate Waters instruments. Waters assumes no liability for the failure of those who install, repair, or operate its instruments to comply with any safety precaution.

Task-specific hazard warnings

The following warning symbols alert you to risks that can arise when you operate or maintain an instrument or instrument component. Such risks include burn injuries, electric shocks, ultraviolet radiation exposures, and others.

When the following symbols appear in a manual’s narratives or procedures, their accompanying text identifies the specific risk and explains how to avoid it.

- **Warning:** (General risk of danger. When this symbol appears on an instrument, consult the instrument’s user documentation for important safety-related information before you use the instrument.)
- **Warning:** (Risk of burn injury from contacting hot surfaces.)
- **Warning:** (Risk of electric shock.)
- **Warning:** (Risk of fire.)
- **Warning:** (Risk of needle puncture.)
- **Warning:** (Risk of injury caused by moving machinery.)
- **Warning:** (Risk of exposure to ultraviolet radiation.)
- **Warning:** (Risk of contacting corrosive substances.)
- **Warning:** (Risk of exposure to a toxic substance.)
- **Warning:** (Risk of personal exposure to laser radiation.)
Warnings that apply to particular instruments, instrument components, and sample types

The following warnings can appear in the user manuals of particular instruments and on labels affixed to them or their component parts.

Burst warning

This warning applies to Waters instruments fitted with nonmetallic tubing.

**Warning:** Pressurized nonmetallic, or polymer, tubing can burst. Observe these precautions when working around such tubing:
- Wear eye protection.
- Extinguish all nearby flames.
- Do not use tubing that is, or has been, stressed or kinked.
- Do not expose nonmetallic tubing to incompatible compounds like tetrahydrofuran (THF) and nitric or sulfuric acids.
- Be aware that some compounds, like methylene chloride and dimethyl sulfoxide, can cause nonmetallic tubing to swell, which significantly reduces the pressure at which the tubing can rupture.

Mass spectrometer flammable solvents warning

This warning applies to instruments operated with flammable solvents.

**Warning:** Where significant quantities of flammable solvents are involved, a continuous flow of nitrogen into the ion source is required to prevent possible ignition in that enclosed space. Ensure that the nitrogen supply pressure never falls below 690 kPa (6.9 bar, 100 psi) during an analysis in which flammable solvents are used. Also ensure a gas-fail connection is connected to the LC system so that the LC solvent flow stops if the nitrogen supply fails.
Mass spectrometer shock hazard

This warning applies to all Waters mass spectrometers.

**Warning:** To avoid electric shock, do not remove the mass spectrometer’s protective panels. The components they cover are not user-serviceable.

This warning applies to certain instruments when they are in Operate mode.

**Warning:** High voltages can be present at certain external surfaces of the mass spectrometer when the instrument is in Operate mode. To avoid non-lethal electric shock, make sure the instrument is in Standby mode before touching areas marked with this high voltage warning symbol.

Biohazard warning

This warning applies to Waters instruments that can be used to process material that might contain biohazards: substances that contain biological agents capable of producing harmful effects in humans.

**Warning:** Waters's instruments and software can be used to analyze or process potentially infectious human-sourced products, inactivated microorganisms, and other biological materials. To avoid infection with these agents, assume that all biological fluids are infectious, observe Good Laboratory Practices and, consult your organization’s biohazard safety representative regarding their proper use and handling. Specific precautions appear in the latest edition of the US National Institutes of Health (NIH) publication, *Biosafety in Microbiological and Biomedical Laboratories* (BMBL).
Chemical hazard warning

This warning applies to Waters instruments that can process corrosive, toxic, flammable, or other types of hazardous material.

⚠️ ⚠️ ⚠️ **Warning:** Waters instruments can be used to analyze or process potentially hazardous substances. To avoid injury with any of these materials, familiarize yourself with the materials and their hazards, observe Good Laboratory Practices (GLP), and consult your organization’s safety representative regarding proper use and handling. Guidelines are provided in the latest edition of the National Research Council’s publication, Prudent Practices in the Laboratory: Handling and Disposal of Chemicals.

Caution symbol

The caution symbol signifies that an instrument’s use or misuse can damage the instrument or compromise a sample’s integrity. The following symbol and its associated statement are typical of the kind that alert you to the risk of damaging the instrument or sample.

⚠️ **Caution:** To avoid damage, do not use abrasives or solvents to clean the instrument’s case.

Warnings that apply to all Waters instruments

When operating this device, follow standard quality control procedures and the equipment guidelines in this section.
Attention: Changes or modifications to this unit not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.

Important: Toute modification sur cette unité n'ayant pas été expressément approuvée par l’autorité responsable de la conformité à la réglementation peut annuler le droit de l’utilisateur à exploiter l’équipement.

Achtung: Jedwede Änderungen oder Modifikationen an dem Gerät ohne die ausdrückliche Genehmigung der für die ordnungsgemäße Funktionstüchtigkeit verantwortlichen Personen kann zum Entzug der Bedienungsbefugnis des Systems führen.

Avvertenza: qualsiasi modifica o alterazione apportata a questa unità e non espressamente autorizzata dai responsabili per la conformità fa decadere il diritto all'utilizzo dell'apparecchiatura da parte dell'utente.

Atención: cualquier cambio o modificación efectuado en esta unidad que no haya sido expresamente aprobado por la parte responsable del cumplimiento puede anular la autorización del usuario para utilizar el equipo.

주의: 규정 준수를 책임지는 당사자의 명백한 승인 없이 이 장치를 개조 또는 변경할 경우, 이 장치를 운용할 수 있는 사용자 권한의 효력을 상실할 수 있습니다.

注意：未經有關法規認證部門允許對本設備進行的改變或修改,可能會使使用者喪失操作該設備的權利。

注意：未经有关法规认证部门明确允许对本设备进行的改变或改装，可能会使使用者丧失操作该设备的合法性。

주의: 규정 준수를 책임지는 당사자의 명백한 승인 없이 이 장치를 개조 또는 변경할 경우, 이 장치를 운용할 수 있는 사용자 권한의 효력을 상실할 수 있습니다.
**Warning:** Use caution when working with any polymer tubing under pressure:

- Always wear eye protection when near pressurized polymer tubing.
- Extinguish all nearby flames.
- Do not use tubing that has been severely stressed or kinked.
- Do not use nonmetallic tubing with tetrahydrofuran (THF) or concentrated nitric or sulfuric acids.
- Be aware that methylene chloride and dimethyl sulfoxide cause nonmetallic tubing to swell, which greatly reduces the rupture pressure of the tubing.

**Attention:** Manipulez les tubes en polymère sous pression avec précaution:

- Portez systématiquement des lunettes de protection lorsque vous vous trouvez à proximité de tubes en polymère pressurisés.
- Eteignez toute flamme se trouvant à proximité de l'instrument.
- Evitez d'utiliser des tubes sévèrement déformés ou endommagés.
- Evitez d'utiliser des tubes non métalliques avec du tétrahydrofurane (THF) ou de l'acide sulfurique ou nitrique concentré.
- Sachez que le chlorure de méthylène et le diméthylesulfoxide entraînent le gonflement des tuyaux non métalliques, ce qui réduit considérablement leur pression de rupture.

**Vorsicht:** Bei der Arbeit mit Polymerschläuchen unter Druck ist besondere Vorsicht angebracht:

- In der Nähe von unter Druck stehenden Polymerschläuchen stets Schutzbrille tragen.
- Alle offenen Flammen in der Nähe löschen.
- Keine Schläuche verwenden, die stark geknickt oder überbeansprucht sind.
- Nichtmetallische Schläuche nicht für Tetrahydrofuran (THF) oder konzentrierte Salpeter- oder Schwefelsäure verwenden.
- Durch Methylenechlorid und Dimethylsulfoxid können nichtmetallische Schläuche quellen; dadurch wird der Berstdruck des Schlauches erheblich reduziert.
Attenzione: fare attenzione quando si utilizzano tubi in materiale polimerico sotto pressione:
- Indossare sempre occhiali da lavoro protettivi nei pressi di tubi di polimero pressurizzati.
- Spegnere tutte le fiamme vive nell'ambiente circostante.
- Non utilizzare tubi eccessivamente logorati o piegati.
- Non utilizzare tubi non metallici con tetraidrofurano (THF) o acido solforico o nitrico concentrati.
- Tenere presente che il cloruro di metilene e il dimetilsolfossido provocano rigonfiamenti nei tubi non metallici, riducendo notevolmente la pressione di rottura dei tubi stessi.

Advertencia: se recomienda precaución cuando se trabaje con tubos de polímero sometidos a presión:
- El usuario deberá protegerse siempre los ojos cuando trabaje cerca de tubos de polímero sometidos a presión.
- Si hubiera alguna llama las proximidades.
- No se debe trabajar con tubos que se hayan doblado o sometido a altas presiones.
- Es necesario utilizar tubos de metal cuando se trabaje con tetrahidrofurano (THF) o ácidos nítrico o sulfúrico concentrados.
- Hay que tener en cuenta que el cloruro de metileno y el sulfóxido de dimetilo dilatan los tubos no metálicos, lo que reduce la presión de ruptura de los tubos.

警告:當在有壓力的情況下使用聚合物管線時,小心注意以下幾點。
- 當接近有壓力的聚合物管線時一定要戴防護眼鏡。
- 熄滅附近所有的火焰。
- 不要使用已經被壓瘪或嚴重彎曲管線。
- 不要在非金屬管線中使用四氫呋喃或濃硝酸或濃硫酸。
- 要了解使用二氯甲烷及二甲基亞楓會導致非金屬管線膨脹,大大降低管線的耐壓能力。
Warnings that apply to all Waters instruments

警告：当有压力的情况下使用管线时，小心注意以下几点：
- 当接近有压力的聚合物管线时一定要戴防护眼镜。
- 熄灭附近所有的火焰。
- 不要使用已经被压瘪或严重弯曲的管线。
- 不要在非金属管线中使用四氢呋喃或浓硝酸或浓硫酸。
- 要了解使用二氯甲烷及二甲基亚枫会导致非金属管线膨胀，大大降低管线的耐压能力。

경고: 가압 플라스틱 튜브로 작업할 경우에는 주의하십시오.
- 가압 플라스틱 튜브 근처에서는 항상 보호 안경을 착용하십시오.
- 근처의 화기를 모두 꺼십시오.
- 심하게 변형되거나 꼬인 튜브는 사용하지 마십시오.
- 비금속(nonmetallic) 튜브를 테트라히드로프uran(Tetrahydrofuran: THF) 또는 농축 질산 또는 황산과 함께 사용하지 마십시오.
- 염화 메틸렌(Methylene chloride) 및 디메틸.sul 포사이드(Dimethyl sulfoxide)는 비금속 튜브를 부풀려 튜브의 과열 압력을 크게 감소시킬 수 있으므로 유의하십시오.

警告：圧力のかかったポリマーチューブを扱うときは、注意してください。
- 加圧されたポリマーチューブの付近では、必ず保護メガネを着用してください。
- 近くにある火を消してください。
- 著しく変形した、または折れ曲がったチューブは使用しないでください。
- 非金属チューブには、テトラヒドロフラン(THF)や高濃度の硝酸または硫酸などを流さないでください。
- 塩化メチレンやジメチルスルホキシドは、非金属チューブの膨張を引き起こす場合があり、その場合、チューブは極めて低い圧力で破裂します。

Warnings that apply to all Waters instruments  A-9
**Warning:** The user shall be made aware that if the equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be impaired.

**Attention:** L’utilisateur doit être informé que si le matériel est utilisé d’une façon non spécifiée par le fabricant, la protection assurée par le matériel risque d’être défectueuses.

**Vorsicht:** Der Benutzer wird darauf aufmerksam gemacht, dass bei unsachgemäßer Verwendung des Gerätes die eingebauten Sicherheitseinrichtungen unter Umständen nicht ordnungsgemäß funktionieren.

**Attenzione:** si rende noto all’utente che l’eventuale utilizzo dell’apparecchiatura secondo modalità non previste dal produttore può compromettere la protezione offerta dall’apparecchiatura.

**Advertencia:** el usuario deberá saber que si el equipo se utiliza de forma distinta a la especificada por el fabricante, las medidas de protección del equipo podrían ser insuficientes.

警告：使用者必須非常清楚如果設備不是按照製造廠商指定的方式使用，那麼該設備所提的保護將被削弱。

警告：使用者必须非常清楚if设备不是按照制造厂商指定的方式使用，那么该设备所提供的保护将被削弱。

경고：제조업체가 명시하지 않은 방식으로 장비를 사용할 경우 장비가 제공하는 보호 수단이 제대로 작동하지 않을 수 있다는 점을 사용자에게 반드시 인식시켜야 합니다。

警告：ユーザーは、製造元により指定されていない方法で機器を使用すると、機器が提供している保証が無効になる可能性があることに注意して下さい。
### Electrical and handling symbols

#### Electrical symbols

These can appear in instrument user manuals and on the instrument’s front or rear panels.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Electric power on" /></td>
<td>Electrical power on</td>
</tr>
<tr>
<td><img src="image" alt="Electric power off" /></td>
<td>Electrical power off</td>
</tr>
<tr>
<td><img src="image" alt="Standby" /></td>
<td>Standby</td>
</tr>
<tr>
<td><img src="image" alt="Direct current" /></td>
<td>Direct current</td>
</tr>
<tr>
<td><img src="image" alt="Alternating current" /></td>
<td>Alternating current</td>
</tr>
<tr>
<td><img src="image" alt="Protective conductor terminal" /></td>
<td>Protective conductor terminal</td>
</tr>
<tr>
<td><img src="image" alt="Frame, or chassis, terminal" /></td>
<td>Frame, or chassis, terminal</td>
</tr>
<tr>
<td><img src="image" alt="Fuse" /></td>
<td>Fuse</td>
</tr>
<tr>
<td><img src="image" alt="Recycle symbol" /></td>
<td>Recycle symbol: Do not dispose in municipal waste.</td>
</tr>
</tbody>
</table>
Handling symbols

These handling symbols and their associated text can appear on labels affixed to the outer packaging of Waters instrument and component shipments.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Up Right" /></td>
<td>Keep upright!</td>
</tr>
<tr>
<td><img src="image" alt="Keep Dry" /></td>
<td>Keep dry!</td>
</tr>
<tr>
<td><img src="image" alt="Fragile" /></td>
<td>Fragile!</td>
</tr>
<tr>
<td><img src="image" alt="No Hooks" /></td>
<td>Use no hooks!</td>
</tr>
</tbody>
</table>
This appendix provides sample forms for logging important system information. It includes the following forms:

- Database Initialization Parameters
- Database Storage Information (Control file)
- Database Storage Information (Tablespace)
- Data file information
- Redo Log information
- Disk Space Usage Log
- Database Backup Log
- Full Disk Backup Log
- System Service Log
- System Problem Log
- Hardware Service Information Sheet
- Software Service Information Sheet

Contents:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Initialization Parameters</td>
<td>B-3</td>
</tr>
<tr>
<td>Database Storage Information (Control Files)</td>
<td>B-4</td>
</tr>
<tr>
<td>Database Storage Information (Tablespace)</td>
<td>B-5</td>
</tr>
<tr>
<td>Data file Information</td>
<td>B-6</td>
</tr>
<tr>
<td>Data file Information (Redo logs)</td>
<td>B-8</td>
</tr>
<tr>
<td>Disk space usage log</td>
<td>B-9</td>
</tr>
<tr>
<td>Database backup log</td>
<td>B-10</td>
</tr>
<tr>
<td>Full disk backup log</td>
<td>B-11</td>
</tr>
<tr>
<td>System service log</td>
<td>B-12</td>
</tr>
<tr>
<td>System problem log</td>
<td>B-13</td>
</tr>
</tbody>
</table>
## Contents:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware service information sheet</td>
<td>B-14</td>
</tr>
<tr>
<td>Software service information sheet</td>
<td>B-14</td>
</tr>
</tbody>
</table>
Database Initialization Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Instance 1</th>
<th>Instance 2</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle SID</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oracle Database Domain</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oracle Application Drive</td>
<td></td>
<td></td>
<td>There is only one copy of Oracle program files.</td>
</tr>
<tr>
<td>Empower Oracle Database</td>
<td></td>
<td></td>
<td>Called DB_DIRECTORY in DBCA.</td>
</tr>
<tr>
<td>Empower Projects</td>
<td></td>
<td></td>
<td>You must create unique Share Names for each instance.</td>
</tr>
<tr>
<td>Empower Program Files</td>
<td></td>
<td></td>
<td>There is only one copy of the Empower 2 Program files.</td>
</tr>
<tr>
<td>Mirrored Directory</td>
<td></td>
<td></td>
<td>Called DB_MIRROR in DBCA.</td>
</tr>
<tr>
<td>First Archive Directory</td>
<td></td>
<td></td>
<td>Called DB_ARCHIVE in DBCA.</td>
</tr>
<tr>
<td>Second Archive Directory</td>
<td></td>
<td></td>
<td>Called DB_ARCHIVE2 in DBCA.</td>
</tr>
<tr>
<td>Memory allocation</td>
<td></td>
<td></td>
<td>Step 8 of 9 in DBCA. Confirm that the memory allocation is divided sufficiently for each instance. Be sure to reserve enough memory for the operating system.</td>
</tr>
<tr>
<td>Character Set</td>
<td></td>
<td></td>
<td>Must be WEISO8559P2.</td>
</tr>
</tbody>
</table>
Database Storage Information (Control Files)

*Tip:* If you need additional space, attach suitable documentation

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Instance 1</th>
<th>Instance 2</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control File 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Control File 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Control File 3</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Database Storage Information (Tablespace)

**Tip:** If you need additional space, attach suitable documentation.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Instance 1</th>
<th>Instance 2</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index_Data Tablespace</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SYSAUX Tablespace</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SYSTEM Tablespace</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TEMPORARY_DATA Tablespace</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UNDOTBS1 Tablespace</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>USER_DATA Tablespace</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Data file Information

Record the tablespace name, and then record the path and size for each file.

<table>
<thead>
<tr>
<th>Tablespace Name</th>
<th>Instance 1</th>
<th>Instance 2</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tablespace Name</td>
<td>Instance 1</td>
<td>Instance 2</td>
<td>Comment</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------</td>
<td>------------</td>
<td>---------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Data file Information (Redo logs)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Instance 1</th>
<th>Instance 2</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Redo Log Group 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Redo Log Group 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Redo Log Group 3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Redo Log Group 4</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Disk space usage log

<table>
<thead>
<tr>
<th>Date/Initials</th>
<th>Drive</th>
<th>Free Disk Space</th>
<th>Date/Initials</th>
<th>Drive</th>
<th>Free Disk Space</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# Database backup log

<table>
<thead>
<tr>
<th>Date/Initials</th>
<th>Database Disk</th>
<th>Storage Media Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Full disk backup log

<table>
<thead>
<tr>
<th>Date/Initials</th>
<th>Drive Volume Name</th>
<th>Media Label</th>
<th>Backup Set Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
System service log

<table>
<thead>
<tr>
<th>Date/Initials</th>
<th>Service Performed</th>
<th>Service/Company</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# System problem log

<table>
<thead>
<tr>
<th>Date/Initials</th>
<th>Problem Description</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Hardware service information sheet

<table>
<thead>
<tr>
<th>Hardware Technical Support/Repair Terms:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of Service Company:</td>
</tr>
<tr>
<td>Address:</td>
</tr>
<tr>
<td>Telephone Number:</td>
</tr>
<tr>
<td>Contact Person:</td>
</tr>
<tr>
<td>Service Access Number:</td>
</tr>
<tr>
<td>Service Contract Expiration Date:</td>
</tr>
</tbody>
</table>

### Software service information sheet

<table>
<thead>
<tr>
<th>Software Technical Support/Repair Terms:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of Service Company:</td>
</tr>
<tr>
<td>Address:</td>
</tr>
<tr>
<td>Telephone Number:</td>
</tr>
<tr>
<td>Contact Person:</td>
</tr>
<tr>
<td>Service Access Number:</td>
</tr>
<tr>
<td>Service Contract Expiration Date:</td>
</tr>
</tbody>
</table>
Index

**A**
Accounts
  administrator 2-3
  Oracle 3-12
  Oracle Sys 3-12
  Oracle System 3-12
Administrator qualifications 1-5
Alert log
  archiving 3-21
Alias, database 4-4
Archiving projects 2-5
Assign User Types to Users 4-23
Audit trail settings 6-6

**B**
Backing up database 5-2
Backup
cold 5-6
hot 5-6
scripts 5-2
structure 5-10
biohazard warning A-4
Buffered data, description 6-4
Buffering data 6-4, 6-6, 6-9, 6-10
burst warning A-3

**C**
caution symbol A-5
Changing passwords
  Empower 4-6
  Oracle user accounts 3-12
chemical hazard warning A-5
Client
  software description 1-3
Configuration of hardware 1-2

Contacting Waters Technical Service 6-2

**D**
Data buffering 6-4, 6-6, 6-9, 6-10
Database
  backing up 5-2
  files 3-18
  restoring 5-9, 5-18
  scheduling backups 5-7
  shutting down 3-15
  shutting down manually 3-16
  starting up 3-17
  structure 3-18
Database alias 4-4
Database Control console 3-12
  adding as a trusted site 3-2
  database version 3-3
  displaying database status 3-3
  displaying Oracle home location 3-3
  displaying server CPU statistics 3-3
  displaying space usage 3-3
  exiting 3-3
  outstanding alerts 3-3
Database recovery
database drive failure 5-17
  program files drive failure 5-15
  raw data drive failure 5-14, 5-17
Database status
  displaying 3-3
Defining database alias 4-4
Defragmenting
  hard disk 2-6
Delete Named Table Preferences 4-24
Disk space
  checking 2-4
E
electrical symbols A-11
Empower 2
  new features 4-13
Empower 2 FR 5
  New features 4-21
  equipment guidelines 5
Error messages 6-16
  database fetch error 6-10
  Empower 6-17
  Oracle 6-17
  printer 6-14
F
Files
  database 3-18
  WatNames.ora 4-4
flammable solvents A-3
Forms B-1
H
handling symbols A-12
Hard disk defragmenting 2-6
Hard disk space, checking 2-4
Hard drive, organization 3-18
Hardware
  configuration 1-2
  problems 6-11
Hot backup 5-6
L
LDAP 4-21
Local security policy
  modifying 4-3
Log forms B-1
Log, system administrator 1-7
Logging in
  Oracle 3-12
M
Managing
  raw data files 4-10
mass spectrometer shock hazard A-4
N
Name resolution 4-4
New features
  Empower 2 FR 5 4-21
O
Oracle accounts 3-12
Oracle database files 3-18
Oracle Sys 3-12
Oracle System 3-12
P
Passwords
  changing 3-12, 4-6
Performing DBA functions 3-12
Privileges
  New Empower 2 FR 5 4-23
Problems, reporting 6-3
Project hierarchies 4-7
  creating 4-7
Projects
  audit trail settings 6-6
Q
Qualifications, administrator 1-5
R
Raw data files, managing 4-10
Raw data share, adding 4-10
Raw data, moving 4-11
Recovery
  database drive failure 5-17
  program files drive failure 5-15
  raw data drive failure 5-14, 5-17
Reporting problems 6-3
Restoring
database 5-9, 5-18

S
safety advisories A-1
Saved Named Table Preferences 4-23
Scheduling
  backups 5-7
Server
  software 1-3
Shutting down
  database 3-15
Software
client 1-3
  requirements 1-3
  server 1-3
Starting up
  database 3-17
symbols
  caution A-5
  electrical A-11
  handling A-12
  warning A-2
SYSDBA functions 3-12
System Administrator
  new functionality in Empower 2
    4-13
System administrator’s log 1-7
System Monitor 4-12

T
Technical support 6-1
Tnsnames
  configuring 4-3
TNSNames.ora file 4-4
Troubleshooting
  hardware 6-11
  procedures 6-16

V
Vista 1-4

W
warning symbols A-2, A-5
Waters Technical Support 6-1
Web Server 4-24